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Section 1

Introduction

January 15, 2004

This guide is intended for users of IGT Progressive Controller (IPC) EZ
Setup software. The IPC EZ Setup software works with the IPC, a
communication controller, to enable operators to configure and run up
to 32 progressive levels on a bank of up to 63 linked and local IGT
slots, video slots, and video poker machines.

Refer to the Glossary on page 65 for definitions of any unfamiliar
terms.

The information in this section includes:
¢ Section 1.1, Typical Linked Local Progressive Configuration

¢ Section 1.2, IGT Progressive Controller EZ Setup Software
Overview

¢ Section 1.3, Understanding Documentation Conventions

Note: Gaming machines are referred to differently depending on the
state or jurisdiction in which the gaming machines are located and the
regulations that exist there. For purposes of this manual, the word
“machine” is used in reference to gaming machines.
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1.1 Typical Linked Local Progressive Configuration

A typical linked local progressive configuration using the IPC consists
of a computer running the EZ Setup software (computer not included),
IGT machines, the controller, a printer, and a progressive display
(progressive display not included). Together, these components allow
you to configure and run Multi-Denomination™ progressives on up to
63 local IGT machines.

As shown in Figure 1-1, machines are connected together to form a
“loop” of machines. The connection between the machines, as well as
the connection from the IPC to the machines and the progressive
display, consists of fiber-optic cables.

TYPICAL LINKED LOCAL PROGRESSIVE CONFIGURATION

COMPUTER WITH EZ SETUP SOFTWARE

NULL-MODEM

IGT PROGRESSIVE CONTROLLER
AND PRINTER

+ PRIZE RESET
+ METER REPORTS
* MACHINE POLLING

FIBER-OPTIC CABLE

PROGRESSIVE
DISPLAY

MACHINES

00001970-061103

Figure 1-1

. Typical Linked Local Progressive Configuration
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Introduction

1.2

Overview

1.2.1

IGT Progressive Controller EZ Setup Software

Use the IPC EZ Setup software to set progressive configuration data
and download the information to the IPC.

EZ Setup Software

Use the menus to:

e open and back
up database files

e set boot and
flash file
locations

e create, save,
delete, print,
import and
export IPC
configurations

* importgame type
paytables

¢ select the serial
port

* get online help

¢ find software
version
information

Use the IPC

Progressive

Groups area to:

* define groups

* define group
levels

January 15, 2004

Getting to Know the IGT Progressive Controller

When the IPC EZ Setup software first opens, the main screen displays.
The main screen consists of several standard areas and buttons as

shown in Screen 1-1.

B IGT Progressive Controller E2 Setup - | Dlil
File Serial Port  Help
—IPC Information
Mame: I Save|PC | —Game Types
Configuration Active Game Types
IPC 1D Murnber: I
Description: ;I Send |PC
Canfiguration
LI Get IPC Add/Remove
Meters | Game Types [
Murber of Defined Levels [baximum 32): |23
—IPC Progressive Groups
G Marne: v Define
raup Name: I J Graupe
Game Type: I Define Group
Levels
Drenomination: I
—Group Paytables
Unreasonable Increment: I
Group Levels Prize 1Dz (Hex]
N
* Display Paytable 1D
;I " Display Paytable Name
IPC Databasze Directory: C:\Documents and SettingsimeelradyDeskiophPCS oftwareh PC.mdb 912 &k

Screen 1-1. Main Screen

Use the IPC

Information area

to:

¢ save and send
IPC
configurations

e get IPC meter
information

Use the Game
Types area to
add and remove
game types

Use the Group
Paytables area to
view a groups
paytables.
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1.3 Understanding Documentation Conventions

The different conventions listed in this section describe how to
interpret symbols, words and phrases used throughout the guide.

Interpreting Notation Conventions

The following words or expressions have particular meanings when
performing steps in a process.

¢ Enter — The user types in the desired information.

¢ Select or Choose — The user initiates a function from a list of
menu tree options using the mouse.

Database fields and menu options appear in italics.
Example: Go to the Player ID# field.
Select Return.

Screen buttons appear in boldface with the title capitalized.
Example: Cancel

On-screen messages appear within quotation marks.
Example: “Do You Wish to Continue?”

Information requiring emphasis appears as follows:

e Tip: — describes information that is recommended for the
succeeding process.

e Note: — describes information that should be taken into account
before proceeding.

e Important: — describes information that must be taken into
account before proceeding.

e Caution: — describes information that must be taken into account
to avoid serious damage to equipment or software.

* WARNING: — describes information that must be taken into
account to avoid personal injury.

Interpreting Mouse Conventions

Since a mouse can be used with the IPC EZ Setup system,
understanding terms related to the mouse is important.

“Click” means to press and release the mouse button without moving
the mouse.
Example: Click View.

January 15, 2004
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“Double-click” means to click the mouse button twice quickly without
moving the mouse.
Example: Double-click on the upper-left button.

Interpreting Keyboard Conventions

January 15, 2004

Brackets ([]) are used to differentiate between function keys and
alphanumeric or symbol keys.

Example: Press [ESC].

Press C.

A plus sign (+) between two key names means to press both keys at
the same time.

Example: “Press [CTRL]+[F1]” means to press the [CTRL] key and
hold it while pressing the [F1] key.

A comma (,) between two key names means to press and release the
keys one after the other.

Example: “Press [ESC],C” means to press and release the [ESC] key
and then press the C key.






Section 2

IGT Progressive Controller EZ Setup
Software Installation

It is necessary to install the IPC EZ Setup software to configure
progressive levels. The installation program guides you through the
process.

The information in this section includes:
¢ Section 2.1, System Requirements

e Section 2.2, Installing the IGT Progressive Controller EZ Setup
Software

January 15, 2004
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2.1 System Requirements

The IPC EZ Setup software works on computers running a Microsoft®
Windows® 2000 or Windows® XP operating system. Specific
requirements are as follows:

* Microsoft® Windows 2000 or Windows XP operating system
* Microsoft® Internet Explorer version 5.01 or higher

* Minimum 133 MHz processor

* Minimum 128MB RAM

* 600MB free hard-disk space

¢ CD-ROM drive

* Serial port

Note: The IPC EZ Setup software will automatically install the
following two programs if necessary.

* Microsoft® Data Access Component (MDAC) 2.6 (included with
the IPC EZ Setup CD)

® Microsoft® .NET Framework V1.1 (included with the IPC EZ
Setup CD)

8 January 15, 2004
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2.2 Installing the IGT Progressive Controller EZ Setup
Software

The IPC EZ Setup installation program guides you through the
installation process.

1. Insert the IPC EZ Setup CD in the CD-ROM drive.

2. Using Microsoft® Internet Explorer or My Computer, locate the
CD-ROM drive.

3. Double-click setup.exe to start the installation.

4. Follow the on-screen installation instructions. Click OK to
continue or Cancel to exit without installing the software.

Note: For more detailed information, see the ReadMe file located on
the IPC EZ Setup CD.

January 15, 2004 9






Section 3

Using the IGT Progressive
Controller EZ Setup Software

January 15, 2004

The IPC EZ Setup software program is designed to be an easy-to-use
utility for configuring progressive prizes. This section includes
detailed instructions for operating the IPC EZ Setup software. For
general information about the IPC and IPC EZ Setup software,
including illustrations and a main screen overview, refer to Section 1
on page 1. For troubleshooting information, refer to Section 4 on
page 51.

The information in this section includes:
¢ Section 3.1, Getting Started
¢ Section 3.2, Working with Progressive Configurations
¢ Section 3.3, Working with a Database
¢ Section 3.4, Working with Game Types
¢ Section 3.5, Working with Progressive Groups
¢ Section 3.6, Working with Progressive Levels

¢ Section 3.7, Retrieving IGT Progressive Controller Meter
Information

11
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3.1 Getting Started

The IPC EZ Setup software is designed to guide you through the first
configuration. Before sending a configuration to the IGT Progressive
Controller:

e Set the boot and flash files (refer to Section 3.1.2 and 3.1.3).
¢ Import paytables for games (refer to Section 3.1.4)

¢ Connect the IGT Progressive Controller EZ Setup computer and
the IPC unit with a null modem cable (refer to Section 3.2.10).

¢ Set the IPC unit to configuration mode (refer to the IGT
Progressive Controller Operator’s Guide).

¢ Set the IGT Progressive Controller EZ Setup computer’s serial
port for the null modem cable connection (refer to Section 3.2.10).

3.1.1 Setting a Database File

The database file contains configuration information for the
progressive games.

To set a database file:

1. Select Open Database from the File menu to open the Open the
Database window.

Look i [ 23 IPC EZ Setup | - ®EeE
|_BinFiles
|_1Docs
-1 Graphics
| 1Meters
[:I Suppart
[E71PC.mdb
File name: I j DOpen I
| Files of Iype: IDatabase Files [*.mdb] j Cancel |
7

Screen 3-1. Opening the Database File

2. Select IPC.mdb and click Open to open the IGT Progressive
Controller window and display the database information.

12 January 15, 2004
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3.1.2 Setting a Boot File Location

The boot file enables the IPC EZ Setup software and the IPC unit to
communicate.

To set a boot file location:

1. Select Set Boot File Location from the File menu to open the Set Boot
File window.

Look i [ 23 IPC EZ Setup | - ®EeE

|_BinFiles
|_1Docs
-1 Graphics
| 1Meters

[:I Suppart

File name: || j DOpen I
N Files of type: | Bin Files [*.bin) | Cancel |
F

Screen 3-2. Setting the Boot File

2. Select the BinFiles folder and click Open to display the contents of

the BinFiles folder.
21
Laok jr: | (3 BirFiles 7] e mckE

#[{CPEO00GA, BIN;

8] CPFO0154,BIN

File name: I j DOpen I
N Files of type: | Bin Files [*.bin) | Cancel |

7

Screen 3-3. Setting the Boot File
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3. Select a boot file and click Open to set the IPC EZ Setup boot file.

Note: The current location of the boot file displays if the boot file was
previously set.

Current Boot File: C:\Program Files\IGT' IPC EZ Setup'BinFiles' CPEODOGAEI! ﬂﬂ
Laok jr: | (3 BirFiles = e & ek B
CPBOODGA.EIN
CPFOO154.EIN
File name: || j DOpen I
| Files of Iype: IBin Files [*.bin) j Cancel /l
%

3.1.3  Setting a Flash File Location

The flash file enables the IPC EZ Setup software and the IPC unit to
communicate.

To set a flash file:

1. Select Set Flash File Location from the File menu to open the Set
Flash File Location window.

2| ]
Look jn: I@ BinFiles j - £k B

CPBOODGA.EIN
CPFOO154.EIN

File name: || j DOpen I
- C | |
J ance I}

N Files of type: | Bin Files [*.bin)

Screen 3-4. Setting the Flash File
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2. Select a flash file and click Open to set the IPC EZ Setup flash file.

Note: The current location of the flash file displays if the flash file was
previously set.

Current Flash File: C:\Program Files,IGTIPC EZ Setup' BinFiles'CPFOD1SAE ﬂﬂ
Look jr: I ] BinFiles j - I‘j‘ v
CPBO0OGA.BIN
CPFO0154.BIN
File name: I j DOpen I
" Files of type: | Bin Fies (* bin) | Cancel /|
%

3.1.4 Importing Game Type Paytables

Game type paytables contain configuration information for the
progressive games.

To import a game type paytable:

1. Select Import Game Type Paytables from the File menu to open the
Import Game Set File window.

Lok jr: I@ Paytables j L] £F B

File name: I j DOpen I
- C | |
J ance I}

N Files of type: |IGT Files [%it)

Screen 3-5. Importing the Game Type Paytables File

2. Select a game type paytable file and click Open to add the game
types to the database.
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3.2 Working with Progressive Configurations

The following information provides details regarding the setup and
maintenance of an IPC configuration.

3.2.1 IPC Numbers

The IPC ID Number is the unique identification number stored in an
IGT Progressive Controller unit as the IPC ID.

IGT recommends using the serial number of each IGT Progressive
Controller unit as its IPC ID number.

To set a progressive configuration to connect the IGT Progressive
Controller EZ Setup computer through the established serial ports
null-modem cable to the IGT Progressive Controller unit:

1. Set the unique IPC ID number for the IGT Progressive Controller
unit (refer to the IGT Progressive Controller Operator’s Guide).

2. Open the desired progressive configuration in the IGT Progressive
Controller EZ Setup window (refer to Section 3.2.4).

16 January 15, 2004
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B IGT Progressive Controller EZ2 Setup i im] 5

File Serial Port Help

r—IPC Infarmation
M ame:
IPC 1D Mumnber:

Description:

Save IPC [~ Game Types

Game King 2 Groups Test Gt et

Active Game Types

Add/Remave |
Get IPC Game Types
Mumber of Defined Levels [Maximum 32]: |1 Meters |

Send [FC K.eno [MOODOZET)
;I Configuration
Update [PC
Flash

—IPC Progressive Groups

Group Mame: IGame King 2 Groups Group 1 - Define |
Groups
Group Mumber: |1
Drefine Group
Game Type:  |Keno (MOODDE67) Levels

Denomination:  [0.01

L«

—Group Paytables
Unreazonable Increment: |1 00000.00
k012131
Group Levels Frize 1Dz [Hex]
10 Hitz, 10 Marked Ox101
' Display Paytable/Config Mame
" Display Paytable Description
IPC Databaze Directory: C:\Program FilestGTAPC EZ SetuphPC.mdb | 9:54 Ak

Screen 3-6. Setting the IPC ID Number

3. Enter the same IPC ID number set in the IGT Progressive
Controller unit in the IPC ID Number field of the IPC Information
area of the IGT Progressive Controller EZ Setup window.

4. Select Save IPC Configuration or the Save IPC Configuration As from
the File menu to save the progressive configuration.

17
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To provide a detailed description of the settings, location and use of a

progressive configuration:

1.

Open the desired progressive configuration in the IGT Progressive

Controller EZ Setup window (refer to Section 3.2.4).

i
File Serial Port Help
r—IPC Infarmation
MName: IGame King 2 Groups Test Save IPC B Topes
Configuration X
Active Game Types
IPC ID Mumber: |1 234
Send IPC K.eno [MOODOZET)
- Configuration
Description:
Update [PC
Flash
LI Add/Remave |
Get IPC Game Types
Mumber of Defined Levels [Maximum 32]: |1 Meters |
—IPC Progressive Groups
Group Mame: IGame King 2 Groups Group 1 j Define |
Groups
Group Mumber: |1
Drefine Group
Game Type:  |Keno (MOODDE67) Levels
Denomination:  [0.01
—Group Paytables
Unreazonable Increment: |1 00000.00
k012131
Group Levels Frize 1Dz [Hex]
10 Hits, 10 Marked Ox101
' Display Paytable/Config Mame
" Display Paytable Description
IPC Databaze Directory: C:\Program FilestGTAPC EZ SetuphPC.mdb | 10:09 Abd

Screen 3-7. Entering the IPC Description

2. Enter information describing the displayed progressive
configuration in the Description field of the IPC Information area of
the IGT Progressive Controller EZ Setup window.

18

Up to five lines at a time display in the Descriptions field.

Click the up/down arrow buttons to display descriptions longer
than the five displayed lines.

Select Save IPC Configuration or the Save IPC Configuration As from
the File menu to save the progressive configuration.

January 15, 2004
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3.2.3 Creating an IGT Progressive Controller Configuration

To create an IPC configuration:

1. Select New IPC Configuration from the File menu to open the New
IPC Configuration window.

EsiNew IPC Configuration i im] 5

Existing IPC Configurations

IPC Name |_IPC Number |
Game King 2 Groups Test 1

Game King Single Group Test
Mulitplay Poker 2 Groups test
Mulitplay Poker Group Test
Test

0
0
0
0

Mewy IPC Mame: ||

Ck Cancel

Screen 3-8. Creating a New IGT Progressive Controller Configuration

2. Enter a unique name for the new configuration in the New IPC
Name field and click OK to open the IGT Progressive Controller EZ
Setup window and display the new configuration.

3.2.4 Opening an IGT Progressive Controller Configuration

To open and view details of an IPC configuration:

1. Select Open IPC Configuration from the File menu to open the Open
IPC Configuration window.

January 15, 2004 19
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&5 0pen IPC Configuration i im] 5

Existing IPC Configurations

IPC Name |_IPC Number |
Game King 2 Groups Test
Game King Single Group Test
Mulitplay Poker 2 Groups test
Mulitplay Poker Group Test
My IPC Configuration

Test

coooo =

Ck Cancel

Screen 3-9. Opening an IPC Configuration

2. Select a configuration and click OK to open the IGT Progressive
Controller EZ Setup window and display the configuration.

3.2.,5 Saving and Renaming an IGT Progressive Controller
Configurations and Templates

You can open an existing configuration and save it under a new name
or as a template or after entering new information for a configuration,
save the configuration so you do not lose valuable data.

Saving and Renaming a Configuration

To save the configuration settings displayed in the IGT Progressive
Controller EZ Setup window, select Save IPC Configuration from the
File menu or click Save IPC Configuration.

To save the configuration under a new name:

1. Select Save IPC Configuration As from the File menu to open the
Save IPC Configuration As window.

20 January 15, 2004
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#siSave IPC Configuration As... i im] 5

Existing IPC Configurations

IPC Name |_IPC Number |
Game King 2 Groups Test
Game King Single Group Test
Mulitplay Poker 2 Groups test
Mulitplay Poker Group Test
My IPC Configuration

Test

coooo =

Save Az Mame: ||

Ck Cancel

Screen 3-10. Saving and Renaming an IPC Configuration

2. Enter a unique name for the configuration in the Save As Name field
and click OK to open the IGT Progressive Controller EZ Setup
window and display the configuration.

Saving a Configuration as a Template

If you have created a configuration you would like to use as a template
starting point for other configurations:

1. Select Save IPC Configuration As from the File menu to open the
Save IPC Configuration As window.

#siSave IPC Configuration As... i im] 5

Existing IPC Configurations

IPC Name |_IPC Number |
Game King 2 Groups Test
Game King Single Group Test
Mulitplay Poker 2 Groups test
Mulitplay Poker Group Test
My IPC Configuration

Test

coooo =

Save Az Mame: ||

Ck Cancel

Screen 3-11. Saving an IPC Configuration Template

January 15, 2004 21
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2. Enter a unique name for the configuration template in the Save As

Name field and click OK to open the IGT Progressive Controller EZ
Setup window and display the configuration template’s settings.

Creating a Configuration from a Template

If you want to create a new IPC configuration from a template:

1.

#siSave IPC Configuration As... i im] 5

Select Save IPC Configuration from the File menu to save the
template before making any changes.

Select Save IPC Configuration As from the File menu to open the
Save IPC Configuration As window.

Existing IPC Configurations

IPC Name |_IPC Number |
Game King 2 Groups Test
Game King Single Group Test
Mulitplay Poker 2 Groups test
Mulitplay Poker Group Test
My IPC Configuration

Test

coooo =

Save Az Mame: ||

Ck Cancel

Screen 3-12. Creating a Configuration from a Template

3.

22

Enter a unique name for the configuration in the Save As Name field
and click OK to open the IGT Progressive Controller EZ Setup
window and display the configuration’s starting point settings.

Change the desired settings in the configuration and select Save
IPC Configuration from the File menu to save the updates to the
configuration without changing the original template.
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3.2.6 Deleting an IGT Progressive Controller Configuration

#siSave IPC Configuration As... i im] 5

Existing IPC Configurations

IPC Name |_IPC Number |
Game King 2 Groups Test
Game King Single Group Test
Mulitplay Poker 2 Groups test
Mulitplay Poker Group Test
My IPC Configuration

Test

coooo =

Save Az Mame: ||

Ck Cancel

Deleting a configuration permanently removes the configuration from
the IPC EZ Setup software.

To delete a configuration:

1. Select Delete IPC Configuration from the File menu to open the
Delete IPC Configuration window.

#siDelete IPC Configuration i im] 5

Existing IPC Configurations

IPC Name | IPC Number |

Game King 2 Groups Test
Game King Single Group Test

Mulitplay Poker 2 Groups test
Mulitplay Poker Group Test
My IPC Configuration

My IPC Configuration 2

Test

cooooo =

Ck Cancel

Screen 3-13. Deleting an IPC Configuration

2. Select a configuration to delete and click OK to delete the
configuration from the IPC EZ Setup software.

January 15, 2004 23
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3.2.7 Printing an IGT Progressive Controller Configuration

To print a hardcopy of a progressive configuration’s details:

1. Select Print IPC Configuration from the File menu to open the Print
window.

R i

Frinting Content
Frint Preview

[V Group Configuration

i

Frint...

[" Available Paptables

FPage Settings... |

|F'rinting Statuzs

Screen 3-14. Printing an IPC Configuration

2. Check the Group Configuration check box to display a group’s
configuration and levels settings:

3. Check the Available Paytables check box to display available
paytables ID code, description, and payback percentage.

4. Click Print Preview to preview how the hard copy will print
before sending it to the printer.

5. Click Page Settings to make any changes to how the hard copy
page will appear before sending it to the printer.

Note: Use the default print settings in the Page Settings window to
maximize the printed results.

6. Click Print to access the print settings for your printer.

7. From your printer’s print settings screen, click Print.

Note: For most printers, the printer software button name is “Print”;
however, the name of this button may be different (such as “OK”)
based on the type of printer you are using.
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3.2.8 Importing an IGT Progressive Controller Configuration

Importing a configuration allows the user to take a configuration from
another computer and load it into EZ Setup.

To import a configuration:

1. Select Import IPC Configuration from the File menu to open the
Import Configuration File window.

Lok jr: I@ Database j = & EB-
test.ipc
: File name: || j DOpen I
" Files of type: IIPE Files [*ipc) j Cancel |
7

Screen 3-15. Importing an IPC Configuration File

2. Select a configuration to import and click Open to open the IGT
Progressive Controller EZ Setup window and display the
configuration.

3.2.9 Exporting an IGT Progressive Controller Configuration

Exporting a progressive configuration allows you to create a
configuration on a different computer and load it into a new computer
without overwriting the entire database file. It also allows you to send
a problematic configuration to IGT should problems arise.

To export a configuration:

1. Select Export IPC Configuration from the File menu to open the
Export Configuration File window.
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Export Configuration File 2=l

Save jm I@ Database j & & EB-

File name: Itest.ipc j Save I
" Save as bype: IIPE Files [*ipc) j Cancel |
¥

Screen 3-16. Exporting an IPC Configuration File

2. Enter a unique name for the configuration in the File Name field
and click Save.

3.2.10 Setting the Serial Port

Serial ports are a device on a computer for inputting and outputting
information. A “null modem” cable connected to the IPC and the
computer on which the EZ Setup program is installed is required for
sending configurations to the controller. Ask your IT professional if
you are not sure which port you need to use.

To setup the serial port, select the IGT Progressive Controller EZ Setup
computer’s Port number for the null-modem cable connection from the
Serial Port menu.

B IGT Progressive Controller EZ2 Setup

File | Serial Part  Help
v Port 1
b7 Part 2
IFETE 3 Game King 2 Groups Test !
Part 4 Cc

IPCID Mumber: |1

. Cc
Description: ;I =

Screen 3-17. Setting the Serial Port
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3.2.11 Sending a Progressive Configuration from the IGT
Progressive Controller EZ Setup Software to the IGT
Progressive Controller Unit

Before sending a configuration to the IGT Progressive Controller:
1. Set the boot and flash files (refer to Section 3.1).

2. Connect the IGT Progressive Controller EZ Setup computer and
the IPC unit with a null-modem cable.

3. Set the IPC unit to configuration mode (refer to the IGT
Progressive Controller Operator’s Guide).

4. Set the IGT Progressive Controller EZ Setup computer’s serial port
for the null-modem cable connection.

To send a configuration to the IPC unit:

1. Open a configuration for display in the IGT Progressive Controller
EZ Setup window (refer to Section 3.2).

2. Click Send IPC Configuration in the IPC Information section of the
IGT Progressive Controller EZ Setup window to open the IPC
Communications window.
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IPC Communications

Configuration Completed Successfully
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okl

Date & Time...Donel

okl

Frogram D Rgst...Donel

IPC Memory kap...Sentl

okl

|PC tMemory tap...Donel

|PC Progreszive Configuration... Sentl

okl

|PC Progreszive Configuration... Donel

|PC Progreszive Paytable Configuration... Sent!
okl

|PC Progreszive Paytable Configuration... Donel
|PC Config Complete...Sentl

okl

Communications Completed

|PC Config Complete...Donel

E

|

E xit

Screen 3-18. Sending an IPC Configuration to the IPC Unit

3. Click Exit after the progress window displays the text IPC Config

Complete...Done!.
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3.3 Working with a Database

The following information provides details regarding the opening and
backing up of an IPC’s database of configurations.

3.3.1 Opening a Database

The database file contains configuration information for progressive
games.

To open the database file:

1. Select Open Database from the File menu to open the Open the
Database window.

Look i [ 23 IPC EZ Setup | - ®EeE

|_BinFiles
|_1Datahase
|_1Docs

-1 Graphics
| 1Meters
[:I Suppart
[E71PC.mdb

File name: || j DOpen I
j Cancel |

| Files of type: IDatabase Filez [*.mdb]
F

Screen 3-19. Opening a Database File

2. Select a database and click OK to open the IGT Progressive
Controller EZ Setup window and display the database.

3.3.2 Backing Up a Database

To back up a database:

1. Select Backup Database from the File menu to open the Backup
Database window.
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Save jm I@IF’E EZ Setup j - £F B
|_BinFiles
|_1Datahase
|_1Docs
-1 Graphics
| 1Meters
[:I Suppart
[E71PC.mdb
| Saveas type: IDatabase Filez [*.mdb] j Cancel |
¥

Screen 3-20. Backing Up a Database File

2. Enter a unique name for the database in the File Name field and

click Save.
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3.4 Working with Game Types

The following information provides details regarding the setup and
maintenance of an IPC configuration’s game types.

3.4.1 Importing Game Type Paytables

Game type paytables contain configuration information for the
progressive games.

To import a game type paytable:

1. Select Import Game Type Paytables from the File menu to open the
Import Game Type Paytables File window.

Lok jr: I@ Paytables j L] £F B

File name: I j DOpen I
" Files of type: [IGT Files [~igt) | Cancel |

7

Screen 3-21. Importing a Game Type Paytables File

2. Select a game type paytable file and click Open to add the game
types to the database.

Note: Importing Game Type Paytables may take several minutes.

3.4.2 Adding and Removing Active Game Types

The active game types determine the paytables available for a
configuration.

To activate or inactivate game types:

1. Click Add/Remove Game Types in the Game Types area of the IGT
Progressive Controller EZ Setup window to open the
Add/Remove Game Types window.
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#s Add/Remove Game Types - |EI|1|
Active Game Types Available Game Types
¥.ena (MO0O0GET] Five Play Poker (MOD00GEZ)

Single Hand Poker [MO000SET)
Slot (MOOD0ZET)

= it ) Ten Play Poker [MODOOS52)
Triple Play Poker [MO000ES2)
== A
Selected

4

Remave ==
Selected

Remave All ==

]

Exit

Screen 3-22. Adding / Removing Game Type Paytables

2. Click a game type or press [CTRL] to select multiple game types
and click Add Selected or Remove Selected to move game types
between the Active Game Types and Available Game Types
window areas.

OR

3. Click Add All or Remove All to move all the game types
displayed between the Active Game Types and Available Game
Types window areas.

Note: Game Types used in a Group Definition of the current
progressive configuration cannot be removed from Active Game Types
before first being removed from the Group Definition (refer to Section
3.5).

4. Click Exit to open the IGT Progressive Controller EZ Setup
window and display the active game types in the Active Game
Types field of the Game Types area.
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3.5 Working with Progressive Groups

A progressive group is a grouping of progressive prize levels under a

unique name with a defined game type, denomination and winning

combination types.

Group Type

51 Group Definitions

An IPC progressive groups’ type is determined by assigning a game

type (poker, keno, slots, etc.) and the game type’s associated paytables
to the progressive group.

To assign a game type to a progressive group, click the Game Type field
to display the active game types and click a game type.

The selected game type determines the paytables displayed in the

Awailable Paytables field of the Paytables and Levels area of the Group
Definitions window.

=101

—IPC Progressive Groups

—Group Definition

Group Mame:

Game Type:
Denomination:

Unreasonable Increment:

Group Mumber:

IM-"' Mew Group j
|1_
| Five Play Poker (M000DES2) |

0m

-

Save
Group

Add Group

Edit Group
ame

Delete
Group

ufiiu

Exit |

Paptable Display Mode

" Display Paytable/Config Mame

' Display Paytable Description

—Paptables and Levels

Contributing Faytables

== A All

== A
Selected

ki

Remave ==
Selected

Remave All ==

|

Available Paytables

EOMLS POKER - 5
- 6P 96.88%
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -

BONMLS POKER

[=

5P 98.01%
5P 98.01%
5P 99.17%
5P 99.17%
5P HiD'enam 97.18%
5P HiD'enam 97.18%
5P HiD'enam 98.31%
5P HiD'enam 98.31%
5P HiD'enam 93.47%
5P HiD'enorn 93.47%
5P SegRF 97.3

>4
5P SeqRF 97.30%

|

Available Levels
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Screen 3-23. Defining a Group
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3.5.2 Group Denomination

An IPC progressive group’s denomination is determined by assigning
a denomination value to the progressive group.

To assign a denomination value to a progressive group, click the
Denomination field to display the available denominations and click a
value (see Screen 3-23).

3.5.3 Unreasonable Increment

An IPC progressive group’s unreasonable increment is determined by
assigning a meter increment amount in pennies to the progressive
group. Upon calculating an unreasonable machine meter increment,
the IPC unit displays an unreasonable increment message and ignores
the progressive meter increment amount. By setting an unreasonable
increment amount IPC operators are notified of machine meter
increments greater than a reasonable amount before the increment
affects the progressive meter display.

To assign an unreasonable increment value to a progressive group,
enter an amount in pennies in the Unreasonable Increment field (see
Screen 3-23).

3.5.4 Paytable Display Mode

To change the way the paytables in the Contributing and Available
Paytables fields of the Paytables and Levels area of the Group
Definitions window display:

Select the Display Paytable/Config Name option button to display the
paytable ID code. Refer to the game type’s paytable reference
documentation to determine the paytable’s game name and payback
percentage.

OR

Select the Display Paytable Description option button to display a
descriptive version of the paytable game name and payback
percentage.
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ﬂ Edit Group
Mame
Delete
Group

|

Paytable Dizplay Mode
=" Display Paytable/Config Mame

F e XTI ST =N
|Display Paytables using the PaytableConl

Using the IGT Progressive Controller EZ Setup Software

j Edit Group
MName
LDelete
Group

" Display Paptable/Config Mame

Payptable Displap Mode
’75' Display Paytable Description

Awailable Paptables

Aailable Levels

| I SRS S S—

Auwailable Paytables

Available Levels

BOMLUS POKER
BOMNLS POKER
BOMUS POKER 96
BOMUS POKER 98.02%
BOWUS POKER 93.17%
DEUCES WILD 100.76%
DEUCES WILD 91.42%

DEUCES WILD 94.82%

DEUCES WILD 36.77%
DEUCES WILD 97.06%
DEUCES WILD 97.58%
DEUCES WILD 38.91%

BOMUS POKER - SeqRF 94 62%
F 37 34

734k

Screen 3-24. Displaying Paytables

3.5.5 Paytable Levels

An IPC progressive group’s available progressive levels are
determined by assigning compatible paytables to the progressive
group. Only paytables with compatible winning combinations can be
grouped to create a progressive meter increment. The royal flush is a
winning combination in many single- and multi-hand poker games
that is not available in keno or slot games.

Available Paytables

January 15, 2004

1. To view an available paytable’s levels of winning combinations,
right-click the paytable name in the Available Paytables field of the
Paytables and Levels area of the Group Definitions window.
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=101

—IPC Progressive Groups

—Group Definition
Group Mame: IM}I MNew Group j
Group Mumber: |1_
Game Type: ISingle Hand Poker (MO000367] j
Denomination: 0.0 hd
Unreasonable Increment: IW

Save
Group

Add Group

Edit Group
ame

Delete
Group

ufiiu

Exit |

Paptable Display Mode

" Display Paytable/Config Mame

' Display Paytable Description

—Paptables and Levels

Contributing Faytables

Available Paytables

Available Levels

BONLS POKER - Seq

BOMUS POKER 34.1
BONLUS POKER 36.87
BONLS POKER 38.0:
BONUS POKER 3317
DEUCES WILD 100.7
DEUCES WILD 3142
DELICES WILD 94.82
DELCES WILD 95.9¢
DEUCES WILD 36.77
DEUCES WILD 97.0¢
DELCES WILD 97 52
DEUCES WILD 38.91

== A All

== A
Selected

Remave ==
Selected

Remave All ==

I

BEOMUS PORER - Seqgf

FF 94.62% ;l
RF 97.34%
pO3673b0 Available Levels

Royal Flush

Straight Flush

Four Aces

Four 25 Thru 45

Four 55 Thru Kings

Full House:

Flush

Straight

Add to Game Set

Screen 3-25. Viewing a Paytable’s Available Levels

2. To select up to two paytable names in the Available Paytable field,
press [CTRL] and right-click on up to two of the selected paytable
names to view both available paytables levels of winning

combinations.
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pO3675b0 Available Levels
Seq Royal Flush
Royal Flush
51 Group Definitions Straight Flush iEixi
Four Aces
Four 25 Thru 45
Four 55 Thru Kings

—IPC Progressive Groups

—Group Definition Ful House Euit |
Group Mame: IM}I Mew Group j Flush
Add to Game Set
Group Mumber: |1 pO3673b0 Available Levels
- Royal Flush
Game Type: ISlngle Hand Poker (MO000367] j Straight Flush - Pagtable Display Mode
Denamination: 0. - IFy 3z " Display Paytable/Config Mame
Four 25 Thru 45 . L
Four Ss Thru Ki ' Display Paytable Description
Unreasonable Increment: |1 00000.00 (el =65 Ul BAnieEs
Full House:
Flush
FPaptables and Levels Straight
Contributing Faytables Awailab Add ta Game Set Awailable Levels

== Add Al

== Add BOMUS POKER 93.17%
Selected DEUCES 'WILD 100.76%
DEUCES WiLD 91.42%
Remave == | |DELICES wILD 94.82%
Selected DEUCES WiLD 95.96%
DEUCES WiLD 96.77%
DEUCES WiLD 97.06%
DEUCES WiLD 97.58%
DEUCES WiLD 98.91% |

Remave All ==

I

Screen 3-26. Viewing the Available Levels of Two Paytables

Contributing Paytables

To assign or remove paytables from the contributing paytables of the
progressive group:

1. Click a paytable name in the Available Paytable field or press
[CTRL] and select multiple paytable names and click Add
Selected or Remove Selected to move paytables between the
Available Paytables and Contributing Paytables window areas.
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=101

—IPC Progressive Groups

—Group Definition

Save
Group

Group Mame:

Group Mumber: |1

IM-"' Mew Group

Add Group

Game Type:
Denomination: 0.0

Unreasonable Increment:

I Single Hand Poker [MO000SET)

-

I‘I 00000.00

Edit Group
ame

Delete

ufiiu

Exit |

" Display Paytable/Config Mame

Paptable Display Mode
|7(3' Dizplay Paytable Description

—Paptables and Levels

Contributing Faytables

== A
Selected
Remave ==
Selected

Remave All ==

l

BONWLS POKER 93.17%
DEUCES WILD 100.76%
DEUCES WILD 31.42%
DEUCES WILD 34.82%
DEUCES WiILD 35.96%
DEUCES WILD 36.77%
DEUCES WILD 37.06%
DEUCES WILD 37 58%
DEUCES WILD 38.91%
DEUCES WILD 33.73%

BONLS POKER - SeqRF 94.623% Royal Fluzh
BONLS POKER 94.18% BONLS POKER 96.87% Straight Flush
== Add Al | BONLS POKER 98.02% Four Aces

Available Levels

Four 25 Thiu 45
Four 5z Thiu Kings
Full House

Flush

Add to Game Set

DOUBLE BOWUS 100.17% LI

Screen 3-27. Assigning / Removing Paytables

2. Click Add All or Remove All to move all the paytables displayed
between the Available Paytables and Contributing Paytables
window areas.

Available Levels

The compatible winning combinations from the paytables
displayed in the Contributed Paytables field display in the
Available Levels field of the Paytables and Levels area of the
Group Definitions window.

3.5.6 Adding, Renaming, Saving and Deleting Progressive

Groups

Adding Groups

To define a group:

1. Click Define Groups in the IPC Progressive Groups area of the IGT
Progressive Controller EZ Setup window to open the Group
Definitions window.
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51 Group Definitions =]

—IPC Progressive Groups

—Group Definition Save _
e |
Group Mame: I j
Group Mumber: I Add Group |
Game Type: IFive Play Poker (MO000EE2) j Edit Graup Paytable Display Mode
[ arme
Denomination: Ig_m vl " Display Paptable/Config Mame
Delete ' Display Paytable Description
Unreasonable [necrement: I Gioup
—Faptables and Levels
Contributing Faytables Ayailable Paytables Awailable Levels

== Acddd Al

== Ao
Selected

Remave ==
Selected

HAldE

Remayve A==

Screen 3-28. Creating New IPC Groups
2. Click Add Group to open the Add a New Group window.

i

Current Groups

ey Group Mame: ||

Ck | Cancel

Screen 3-29. Naming a New IPC Group

3. Enter a descriptive name for the group in the New Group Name field
and click OK to open the Group Definitions window and display
the group information.
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=101

—IPC Progressive Groups

—Group Definition

Group Mame: IM}I MNew Group

Group Mumber: |1

Unreasonable Increment:

Denomination: 0.0

Game Type: IFive Play Poker (MO000652]

-

Save
Group

Add Group

Edit Group
ame

Delete
Group

ufiiu

|

Exit |

Paptable Display Mode

" Display Paytable/Config Mame
' Display Paytable Description

—Paptables and Levels

Contributing Faytables

== A All

== A
Selected

Remave ==
Selected

A

Remave All ==

Available Paytables

BOMUS POKER -5

BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -
BONLS POKER -

5P 96.88%

5P 98.01%

5P 98.01%

5P 99.17%

5P 99.17%

5P HiD'enam 97.18%
5P HiD'enam 97.18%
5P HiD'enam 98.31%
5P HiD'enam 98.31%
5P HiD'enam 93.47%
5P HiD'enorn 93.47%
5P SegRF 97.3

0%
SPSeqRFora0x x|

Available Levels

Screen 3-30. Viewing a Group’s Definitions

Deleting Groups

Editing a Group Name

40

To delete a group:

1. Click the Group Name field to display the current groups and click a

group to delete it (see Screen 3-30).

2. Click Delete Group to delete the selected group displayed in the
Group Name field and click Yes in the Delete Group? window to
delete the group.

To edit the name of a group:

1. Click the Group Name field to display the current groups and click a
group to change its name.

2. Click Edit Group Name to open the Edit Group Name window.
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Saving a Group
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i

Current Groups

My Mew Group

Group MName:

Ck Cancel

Screen 3-31. Editing a Group’s Name

3.

Edit the descriptive name for the group in the Group Name field
and click OK to open the Group Definitions window and display
the group information.

To save a group:

1.

Click the Group Name field to display the current groups and click a
group to save it.

Click Save Group to save the selected group displayed in the
Group Name field.
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3.6 Working with Progressive Levels

TRIPEE{PLAY,

DEUGES WILD

Progressive levels are the different paytable winning combinations
that are compatible across the game type(s) of a progressive group.
Each winning combination level is configured with the same
maximum prize, base and reset amount and contributes the same
percentage of the wager to the progressive pool.

To have a machine’s main menu screen display the game types
available with progressive wins, the Add to Game Set level must first
be configured for each progressive group (refer to Section 3.6.1).

The following sample machine game main menu screen displays the
progressive games available (Triple Play™ Deuces Wild, Triple Play™
Double Bonus and Triple Play™ Double Double Bonus) when the 5¢
or 10¢ denomination is wagered.

ST TRIPLERLAY)| [ TRIPEBPLAY,
SEQUENTIAL ROYAL —— AN Ly A A phrd & L)
BONUS POKER

$601.56

TRIELE/PLAY
SUPER DOUBLE
DOUELE BONUS

FIVE BLEAY,

SUPER DOUBLE
DOUBLE BUNUS

@D (PaiD ) (cReo 50.00) EFED

42

Screen 3-32. Machine Main Menu
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3.6.1 Setting a Progressive Group’s Machine Display Level

The Add to Game Set level is a group level which sets a machine’s
main screen to display the game types available with progressive
wins.

To set Add to Game Set level of a progressive group:

1. Select the desired progressive group in the Group Name field of
the IPC Progressive Groups area of the IGT Progressive Controller
EZ Setup window:

B IGT Progressive Controller EZ2 Setup i im] 5

File Serial Port Help

r—IPC Infarmation

MName: IMy IPC Canfiguration Save IPC B Topes
Configuration X
Active Game Types
IPC 1D Number [0 p—— Five Plap Poker MOOO0EEZ)
Configuration Single Hand Poker [MO000SET)
Description: ;I Ten Play Poker (MO000ES2)
Triple Play Poker [MO000ES2)
Update [PC

Flash
LI Add/Remave
Get IPC Game Types |
Mumber of Defined Levels [Maximum 32]: IU Meters |
—IPC Progressive Groups
Group Mame: IM-"' New Group h Define |
Groups
Group Mumber: |1
- Define Group
Game Type: ISlngle Hand Poker [MO000SE7] Levels

Denomination:  [0.01

L«

—Group Paytables
Unreazonable Increment: |1 00000.00
BOMLS POKER - SeqRF 94.62%
BOMUS POKER 94.18%
Group Levels Frize 1Dz [Hex]
" Display Paytable/Config Mame
' Display Paytable Description
IPC Databaze Directory: C:\Program FilestGTAPC EZ SetuphPC.mdb 8:50 Ak

Screen 3-33. Viewing IPC Groups

2. Click Define Group Levels to open the Group Level Definitions
window and display the progressive group’s level settings.

3. Click the Level field, and select the Add to Game Set option.

4. Click Save Level to save the Add to Game Set level to the Defined
Group field.
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§51 Group Level Definitions =]

Defined Group Levels

Group Mame: ITriple Play 2 Groups group 2

Save Level Add to Game Set

Lewvel: IAdd to Game Set j

Delete Level

I ax Prize: ID

Base Amount: IU Copy Level

Reset Amount: IU Baste Level

Contribution %: ID

< LRRE

¥ Escrow Prize Exit Mumber of Defined Levels [Maximum 32]: |2

Screen 3-34. Establishing a Group’s Add to Game Set Level

5. Click the Level field to display the current levels and click a level to
to display the level’s settings.

3.6.2 Defining the Levels of a Progressive Group

To set the payout level of a winning combination:

§51 Group Level Definitions =]

Defined Group Levels

Group Mame: ITriple Play 2 Groups group 1
Save Level Add to Game Set
Fiopal Flush[all Hands]

(V| F oval FlushlAll Hands) Rayal Flush{Hand 1]

Delete Level

Ma Prize; [10000.00

Base Amount: |1 000.00 Copy Level

Reset dmount:  |1000.00 Faste Level

Contribution %: |.1 1]

¥ Escrow Prize Exit Mumber of Defined Levels [Maximum 32]: |2

f LR

Screen 3-35. Defining a Group’s Level Settings

Click in the appropriate field to define the level settings for a
progressive group. Refer to Table 3-1 for information regarding the
Group Level Definitions fields.
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Table 3-1.
Group Level Definitions Fields
Field Name Description
) The maximum amount in dollars that the level’s
Max Prize

progressive prize pays out.

The start amount in dollars of a progressive level’s

Base Amount .
prize payout.

The amount in dollars the level resets to after a

Reset Amount . .
progressive hit.

The percentage amount of each wager contributed

Contribution % to the progressive pool of the level.

An on/off setting that adds any contributions in
Escrow Prize excess of the Max Prize to the value of the level’s
next reset amount after a progressive hit.

3.6.3 Saving a Level

To save a new level, click Save Level to save a level’s displayed
settings and add the level to the Defined Group Levels field.

To change and save a level’s settings:

1. Click a level in the Defined Group Levels field to display the level’s
settings.

2. Select and change the desired settings of the level and click Save
Level to save a level’s new settings.

3.6.4 Deleting a Level

To delete a level:

1. Click a level in the Defined Group Levels field to display the level’s
settings.

2. Click Delete Level to remove the level to the Defined Group Levels
tield and delete a level’s displayed settings.
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3.6.5 Copying a Level

Copying a level is a convenient way to configure many different levels
with the same settings. In particular, this is used when setting the
individual hands of a multi-hand poker progressive game.

To copy one level’s settings for use with another level:

1. Click a level in the Defined Group Levels field to display the level’s
settings.

2. Confirm the settings to be copied are displayed, then click Copy
Level to copy the displayed settings.

3. Click the Level field, and click the level to receive the copied level
settings.

4. Click Paste Level to paste the copied settings into the displayed
level.

5. Confirm the level’s new settings, then click Save Level to save the
level’s new settings and add the level to the Defined Group Levels
field.
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3.7 Retrieving IGT Progressive Controller
Meter Information

To view the current meters of machines connected to the IGT
Progressive Controller:

1. Open the desired progressive configuration in the IGT Progressive
Controller EZ Setup window.

B IGT Progressive Controller EZ2 Setup i im] 5

File Serial Port Help

r—IPC Infarmation

Save IPC [~ Game Types

Mame: IMy IPC Configuration Configuration

Active Game Types
IPC 1D Number [0 p—— Five Plap Poker MOOO0EEZ)
Configuration Single Hand Poker [MO000SET)
Description: ;I Ten Play Poker (MO000ES2)
Triple Play Poker [MO000ES2)

Update [PC
Flash
LI Add/Remave
Get IPC Game Types
Mumber of Defined Levels [Maximum 32]: IU Meters |

—IPC Progressive Groups

Group Mame: IM-"' New Group Define
Groups
Group Mumber: |1
- Define Group
Game Type: ISlngle Hand Poker [MO000SE7] evels

iy

Denomination:  [0.01

—Group Paytables
Unreazonable Increment: |1 00000.00
BOMLS POKER - SeqRF 94.62%
BOMUS POKER 94.18%
Group Levels Frize 1Dz [Hex]
" Display Paytable/Config Mame
' Display Paytable Description
IPC Databaze Directory: C:\Program FilestGTAPC EZ SetuphPC.mdb 8:50 Ak

Screen 3-36. Viewing IPC Meters
2. Click Get IPC Meters to open the Get IPC Meters window.

i

Select the IPC Meters to report:

Get [PC
[ Paptable Meters ﬂeete[s

[~ Teminal Meters
™ Jackpot Group Meters Exit |

Fiepart Directory: C:\Program Files\IGTYPC EZ Setuphheters’,

Screen 3-37. Acquiring an IPC’s Metered Amounts
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3. Check the Paytable Meters check box to download:
* EGM ID
* Date/Time
* Meter Map ID
* Denomination Code
¢ Paytable ID
* Money Wagered
* Money Won
¢ Jackpot
¢ Handpays
* Games Played
* Max Bet Games Played
* Bonus Events
4. Check the Terminal Meters check box to download:
* EGM ID
¢ Date/Time
* Meter Map ID
* Denomination Code
* Money Wagered
* Money Won
* Games Played
¢ Coin to Drop
5. Check the Jackpot Group Meters check box to download:
* EGM ID
¢ Date/Time
* Meter Map ID
® Denomination Code

¢ Group ID
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* Money Wagered Since Last JP

¢ Progressive Wins

Click Get IPC Meters to download the selected meter readings as
separate comma-delimited files to the directory displayed at the
bottom of the Get IPC Meters window.
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Section 4

Troubleshooting and Accessing

Help

January 15, 2004

The IPC EZ Setup software is designed to be easy to use. When you
have a question, you have several resources for finding a solution.

The information in this section includes:
¢ Section 4.1, Performing Basic Troubleshooting

¢ Section 4.2, Using Online Help

Note: This guide is intended to assist with common IPC EZ Setup
software procedures. For information related to the IPC, refer to the
IGT Progressive Controller Operator’s Guide. For information
related to machine setup, refer to the IGT Progressive Controller
Game Software Setup card.
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4.1 Performing Basic Troubleshooting

Table 4-1 is intended to assist with resolving some common IPC EZ
Setup software issues.

Table 4-1. Common Issues and Solutions

Issue Solution

Currently, only one report prints at a
When | select multiple copies of IPC | time. It is necessary to perform
reports, only one copy prints. printing procedures for each copy of
the report you want to print.

When | download a configuration Press the Continue button on the
that only includes an Add to Game machine to ignore the error and
Set level, | receive a machine error. | continue.

Verify the correct serial port has
been selected from the IPC EZ
Setup Serial Port menu.
Verify that the null-modem cable is
| click Send IPC Configuration (or fggheded to the computer and the
rL}J;Ss;&:}SII-DC Flash) and nothing Verify the RS232 daughter card in
the IPC has the following jumpers:
E2, E4, E6.
The bottom left-most pair of Red/
Green LEDs on the IPC flashes
when communication is occurring.
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4.2 Using Online Help

The IPC EZ Setup software comes with a complete online Help system.

4.2.1 Opening Online Help

To view online Help, click the Help menu and select Help Contents to
open the IGT Progressive Controller EZ Setup Help.

E? IGT Progressive Controller EZ Setup Help - |EI|1|
<= 0}

Hide Back Frint  Options

| v

Cantents | Index I : OWVERVIEW

| Saving Configurations Use the IGT Progressive Controller EZ Setup (IPC EZ Setup) utility prograrm to
@ IPC Information and Game Types configure the progressive prizes. Click on a button to jump to pages regarding

@ Progressive Groups . ;
@ Progreszive Levels the pamcular tOpIC_

@ Communicating with the IPC

a1l |GT; Progressive Controller EZ Setup
File Serial Port Help

IPC Information

Mame: |Game King [MODOO3E7) . Enahvgi [IaPhED . Game Types

Active Game Type

FED Humter ’1—‘ Send IPC Single Hand Poker [MO000E
inti M Slot (MO0DD0ZET)
Drescription:
Update IPC

Flash

Add/Remave

Get [PC Game Types
Mumber of Defined Levels [Maximum 32]: {3 Meters —_—
|IPC Progressive Groups -
d L e

4.2.2 Navigating Online Help

There are a number of ways to navigate through the IGT Progressive
Controller EZ Setup Help.
Using the Navigation Bar

¢ Click Hide to hide the navigation bar so only the topic window
displays.

* Click Show to display the navigation bar.
¢ Click Print to print the topic displayed in the topic window.

¢ Click Options to view more options.
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Finding a Topic Using the Contents Tab:

1.
2.
3.

Click the Contents tab.
Double-click a book to display its related topics.

Click a topic to display it in the topic window.

Finding a Topic Using the Index Tab:

4.2.3

54

1.
2.

Click the Index tab to display the index entries.

Double-click an index entry to display its related topic in the topic
window.

OR
Type in a keyword related to what you want to find.

The program highlights the closest related phrase. Double-click the
index entry to display its related topic in the topic window.

Printing Online Help

You can print a single help topic or all the topics contained in a book.

To print a single topic:

1.
2.
3.

Click the Contents tab.

Click the topic you want to print.

Click Print.

The Print Topics dialogue box displays.
Click the Print the selected topic button.
Click OK.

The Print dialogue box displays to allow you to complete the
printing process.

To print all the topics in a book:

1.
2.
3.

Click the Contents tab.

Click the book you want to print.

Click Print.

The Print Topics dialogue box displays.

Click the Print the selected headings and all subtopics button.
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5. Click OK.

The Print dialog box displays to allow you to complete the printing
process.

4.24  Exiting Online Help

Click the X button in the upper right corner to exit Help.
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Related IGT Documentation

Machine Documentation

IGT machine documentation consists of a series of manuals. Each manual addresses different aspects
of field service as follows:

* Machine specifications — provide environmental, electrical, dimensional, stand, and lock
specifications for IGT machines.

e Machine installation — contains installation instructions for all IGT machines.

¢ Troubleshooting — contains procedures to diagnose and rectify common problems with
hardware components of gaming machines.

* Game software — contains program information required to select options, test, diagnose and
record cumulative data.

* Maintenance procedures — provide complete field service instructions, including removal/
replacement, maintenance and adjustments, disassembly and assembly, and functional
verification, for both optional and standard components.

* Mechanical parts — contain exploded view illustrations and parts lists.

¢ Electronic diagrams and parts — contain connector overviews, wiring diagrams, board
assembly parts lists, and schematics.

Note: IGT machines may be manufactured with components from a third-party vendor. For those
components not documented in this manual, contact the component manufacturer directly.

Systems Documentation

IGT systems documentation provides detailed information about systems operation:

* User’s guides — furnish information regarding system configuration, operations, and
accounting procedures, and provide events lists and report samples.

¢ System hardware guides — contain system-specific hardware information.

* Quick reference cards — offer easy-to-use instructions about systems hardware and software.

Currently Available Documentation

Refer to the following lists for information about currently available documentation.

Visit the IGT Web site, www.IGT.com, for documentation prices and to view selected documentation
online.

January 15, 2004 57



IGT PROGRESSIVE CONTROLLER
EZ SETUP USER’S GUIDE

All Machine-Related Products

Title
* Machine Installation Procedures
» Troubleshooting Game Machines
Game King Machines
All Game King Machines
Title

e 80960 Tester Operator's Manual

* Game King Release 3 Software Quick Reference Cards

* Game King Release 4 Software Quick Reference Cards

* Game King/Vision Series Peripheral Device Download Procedure
e Game Software: Game King Products — Release 4

* Machine Specifications: 80960 Products

Upright Machines
Title
* Electronic Diagrams & Parts: Game King 17" Gaming
* Electronic Diagrams & Parts: Game King 19" Gaming
* Electronic Diagrams & Parts: Game King 19" Lottery (w/Printer)
* Electronic Diagrams & Parts: Game King 13" Gaming

¢ Electronic Diagrams & Parts: Game King 19" European Lottery (w/Printer)

¢ Machine Specifications: 80960 Products

* Maintenance Procedures: Game King 17" Upright

* Maintenance Procedures: Game King/Winner's Choice 19"

* Maintenance Procedures: Winner's Choice 13"

e Mechanical Parts: Game King 13" Gaming

* Mechanical Parts: Game King 17" Upright with Hopper

* Mechanical Parts: Game King 19" Upright with Hopper or Printer
* Winner's Choice 19" Field Service Supplement (ARMY)

Slant-Top Machines
Title
* Electronic Diagrams & Parts: Game King 13" Slant-Top Gaming
* Electronic Diagrams & Parts: Game King 17" Slant-Top Gaming
* Electronic Diagrams & Parts: Game King 19" Slant-Top
* Machine Specifications: 80960 Products
¢ Maintenance Procedures: Game King 13" Slant-Top
¢ Maintenance Procedures: Game King 19" Slant-Top

* Maintenance Procedures: Vision Series/Game King 17" Slant-Top

* Mechanical Parts: Game King 13" Slant-Top
* Mechanical Parts: Game King 17" Slant-Top
* Mechanical Parts: Game King 19" Slant-Top

Flat-Top and Drop-in-bar Machines
Title
Electronic Diagrams & Parts: Game King 13" Flat-Top Gaming
Machine Specifications: 80960 Products
* Maintenance Procedures: Game King 13" Flat-Top
e Mechanical Parts: Game King 13” Flat-Top
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Part Number
821-287-XX
821-283-XX

Part Number
821-333-XX
821-310-XX
821-318-XX
821-198-XX
821-321-XX
821-356-XX

Part Number
821-307-XX
821-242-XX
821-237-XX
821-246-XX
821-239-XX
821-356-XX
821-332-XX
821-236-XX
821-247-XX
821-244-XX
821-306-XX
821-301-XX
821-196-XX

Part Number
821-250-XX
821-269-XX
821-302-XX
821-356-XX
821-266-XX
821-337-XX
821-293-XX
821-251-XX
821-270-XX
821-338-XX

Part Number
821-273-XX
821-356-XX
821-282-XX
821-274-XX
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Game King Plus Machines
Title
* Electronic Diagrams & Parts: Game King Plus 19" Upright (Preliminary)
* Machine Specifications: 80960 Products
* Maintenance Procedures: Game King Plus 19” Upright (Preliminary)
* Mechanical Parts: Game King Plus 19" Upright (Preliminary)

Player’s Edge-Plus Machines

All Player’s Edge-Plus Machines

Title
* Game Software: Player's Edge-Plus Products
e Machine Specifications: 8032 Products
* Player's Edge-Plus International Software Guide
* Player's Edge-Plus Video Tester — Euro Supplement
* Player's Edge-Plus Video Tester Operator's Manual
S-Plus/Player's Edge-Plus Electronics Repair Manual

Upright Machines
Title
* Electronic Diagrams & Parts: Player's Edge-Plus 13” IBA
* Electronic Diagrams & Parts: Player's Edge-Plus 13" Non-IBA
* Euro Supplement — Player's Edge-Plus 13"
* Euro Supplement — Player's Edge-Plus 13" with Touchscreen /Hopper
* Euro Supplement — Player's Edge-Plus 13" with Touchscreen /Printer
e Euro Supplement — Player's Edge-Plus 19"
e Euro Supplement — Player's Edge-Plus IBA
e Euro Supplement — Player's Edge-Plus19" with Touchscreen /Hopper
* Large Screen Player's Edge-Plus Manual
¢ Machine Specifications: 8032 Products
* Maintenance Procedures: Player's Edge-Plus 13" Upright IBA
* Mechanical Parts: Player's Edge-Plus 13" IBA
* Mechanical Parts: Player's Edge-Plus 13" Non-IBA
* Player's Edge-Plus Brazil Field Service Supplement (Upright)
* Player's Edge-Plus Dual Monitor Keno (Upright)
* Player's Edge-Plus Touchscreen Keno Supplement (Upright)
* Player's Edge-Plus Montana Field Service Supplement (Upright)

Slant-Top Machines
Title
* Electronic Diagrams & Parts: Players Edge-Plus Slant-Top
* Euro Supplement — Player's Edge-Plus Slant-Top
* Machine Specifications: 8032 Products
* Maintenance Procedures: Player's Edge-Plus Slant-Top
* Mechanical Parts: Player's Edge-Plus Slant-Top
* Player's Edge-Plus Dual-Monitor Slant-Top Supplement

Flat-Top and Drop-in-bar Machines

Title
* Electronic Diagrams & Parts: Player's Edge-Plus Flat-Top IBA
e Euro Supplement — Player's Edge Plus Drop-In-Bar
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Part Number
821-352-XX
821-356-XX
821-353-XX
821-351-XX

Part Number
821-227-XX
821-357-XX
821-038-XX
821-289-XX
821-052-XX
821-126-XX

Part Number
821-231-XX
821-232-XX
821-193-XX
821-264-XX
821-268-XX
821-208-XX
821-191-XX
821-261-XX
821-095-XX
821-357-XX
821-229-XX
821-230-XX
821-233-XX
821-221-XX
821-069-XX
821-092-XX
821-072-XX

Part Number
821-276-XX
821-195-XX
821-357-XX
821-275-XX
821-277-XX
821-064-XX

Part Number
821-199-XX
821-263-XX

Related IGT Documentation

59



IGT PROGRESSIVE CONTROLLER Related IGT Documentation
EZ SETUP USER’S GUIDE

* Machine Specifications: 8032 Products 821-357-XX
* Maintenance Procedures: Player's Edge-Plus Flat-Top 821-331-XX
* Mechanical Parts: Player's Edge-Plus Flat-Top IBA 821-320-XX
e Player's Edge-Plus Drop-In-Bar Field Service Manual (Flat-Top) 821-158-XX
* Player's Edge-Plus Montana Flat-Top Supplement 821-068-XX

Player’s Choice Machines

Title Part Number
* Player's Choice Arcade Bingo — Game Software Guide 821-094-XX
¢ Player's Choice Arcade Field Service Manual (use with 821-077-01) 821-077-00
¢ Player's Choice Arcade Field Service Manual Addendum

(use with 821-077-00) 821-077-01

* Player's Choice Classic Field Service Manual 821-070-XX
* Player's Choice Software Guide (all games) 821-127-XX
S-Plus Machines
All S-Plus Machines

Title Part Number
* Game Software: S-Plus Products 821-206-XX
¢ Machine Specifications: 8032 Products 821-357-XX
* S-Plus Diagnostic Card Set 821-154-XX
¢ S-Plus International Software Guide 821-047-XX
* S-Plus Stepper Tester — Euro Supplement 821-290-XX
* S-Plus Tester Operator's Manual 821-051-XX
¢ S-Plus Tournament Game Set-up Quick Reference Card 821-292-XX
* S-Plus/Player's Edge-Plus Electronics Repair Manual 821-126-XX
Upright Machines

Title Part Number
* Electronic Diagrams & Parts: S-Plus Upright IBA 821-204-XX
* Electronic Diagrams & Parts: S-Plus Upright Non-IBA 821-225-XX
e Euro Supplement — S-Plus IBA 821-189-XX
* Machine Specifications: 8032 Products 821-357-XX
* Maintenance Procedures: S-Plus Upright Machines 821-203-XX
* Mechanical Parts: S-Plus Upright IBA 821-205-XX
* Mechanical Parts: S-Plus Upright Non-IBA 821-226-XX
e Supplement — Bonus Wheel Machine 821-265-XX
Slant-Top Machines

Title Part Number
* Electronic Diagrams & Parts: S-Plus Slant-Top 821-259-XX
e Euro Supplement — S-Plus Slant 821-194-XX
e Machine Specifications: 8032 Products 821-357-XX
¢ Maintenance Procedures: S-Plus Slant-Top 821-267-XX
* Mechanical Parts: S-Plus Slant-Top 821-258-XX
* Totem Pole Supplement 821-272-XX
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S-Plus Limited Machines
Title
e S-Plus Limited Supplement — Hit the Top
* S-Plus Limited Supplement — Jewel in the Crown
* S-Plus Limited Supplement — Little Devil
¢ S-Plus Limited Supplement — Pinball
¢ S-Plus Limited Supplement — Run For Your Money
¢ S-Plus Limited Supplement — Top Dollar

S2000 Machines

All S2000 Machines
Title
* Game Software: Vision Series/S2000 Products — Release 8
* Machine Specifications: 80960 Products
¢ Quick Reference Cards: Vision/S2000 Software Release 8

S$2000 Upright Machines
Title
* Electronic Diagrams & Parts: Vision/S2000 Slot Upright
S2000-1 Field Service Supplement (Upright)
¢ Maintenance Procedures: Vision/S2000 Slot Upright
* Mechanical Parts: Vision/S2000 Slot Upright
» Top Box Dice Configurations Supplement

$2000 Slant-Top Machines

Title
* Electronic Diagrams & Parts: Vision/S2000 Slot Slant-Top
* Maintenance Procedures: Vision Series/S2000/Game King 17" Slant-Top
¢ Mechanical Parts: Vision/S2000 Slot Slant-Top

Vision Series Machines

All Vision Series Machines
Title
* 80960 Tester Operator's Manual
e Game King/Vision Series Peripheral Device Download Procedure
e Game Software: Vision Series/S2000 Products — Release 8
e Game Software: Vision Series/S2000 Products — Release 9
* Machine Specifications: 80960 Products
¢ Quick Reference Cards: Vision/S2000 Software Release 8
Quick Reference Cards? Vision/S2000 Software Release 9

Upright Machines

Title
* Electronic Diagrams & Parts: Vision/S2000 Slot Upright
* Machine Specifications: 80960 Products
* Maintenance Procedures: Vision/S2000 Slot Upright
* Mechanical Parts: Vision/S2000 Slot Upright
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Part Number
821-312-XX
821-325-XX
821-324-XX
821-305-XX
821-323-XX
821-311-XX

Part Number
821-339-XX
821-356-XX
821-345-XX

Part Number
821-340-XX
821-354-XX
821-294-XX
821-303-XX
821-362-XX

Part Number
821-341-XX
821-293-XX
821-304-XX

Part Number
821-333-XX
821-198-XX
821-339-XX
821-359-XX
821-356-XX
821-345-XX
821-361-XX

Part Number
821-340-XX
821-356-XX
821-294-XX
821-303-XX

Related IGT Documentation
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Slant-Top Machines

Title
Electronic Diagrams & Parts: Vision/S2000 Slot Slant-Top
Machine Specifications: 80960 Products
* Maintenance Procedures: Vision Series/S2000/Game King 17"
Slant-Top
* Mechanical Parts: Vision/S2000 Slant-Top

EZ Pay Products
Title
e EZ Pay Hardware Supplement
* EZ Pay Thermal Printer Quick Reference Cards

Additional Component Products

Bill Acceptor Products

Title
¢ JCM Tester Training Guide
¢ Quick Reference Card, Mars BA-ZT1200
World Bill Acceptor Calibration Procedures
World Bill Acceptor Field Service Manual
World Bill Acceptor Quick Reference Card

CVT and CCOM Products

Title
e CVT Operations Guide (Clerk Validation Terminal)
e CVT/LCT Field Service Manual (use with supplement 821-108-10 or 821-108-20)
e CVT/LCT Gaming Field Service Supplement (use with 821-108-01)
e CVT/LCT Lottery Field Service Supplement (use with 821-108-01)
e CVT-Plus Field Service Manual
e CVT-Plus Operator's Guide
e Euro Supplement — CCOM
e Euro Supplement — CVT
e EZ Route CVT Operator's Guide
e EZ Route CVT-Plus Operator’s Guide
* IGT Progressive Controller Game Software Setup

All SMART Related Products

Title
* SMART Keyboard Template — Club Workstation
* SMART Keyboard Template — Hard Count
e SMART Keyboard Template — Jackpot/Hopper Fill
* SMART Keyboard Template — Security Display
* SMART Keyboard Template — Soft Count
* SMART System Training — Accounting & Auditing Manual
* SMART System Training — Advanced Marketing Workstation Manual
e SMART System Training — Casino Floor Manager
* SMART System Training — Club Functions Manual
* SMART System Training — Club Management Manual
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Part Number
821-341-XX
821-356-XX

821-293-XX
821-304-XX

Part Number
821-220-XX
821-358-XX

Part Number
821-450-XX
821-342-XX
821-271-XX
821-256-XX
821-257-XX

Part Number
821-093-XX
821-108-01
821-108-20
821-108-10
821-255-XX
821-254-XX
821-245-XX
821-260-XX
821-249-XX
821-348-XX
821-364-XX

Part Number
821-183-XX
821-181-XX
821-180-XX
821-179-XX
821-182-XX
821-162-XX
821-167-XX
821-174-XX
821-163-XX
821-164-XX
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SMART System Training — End of Period Manual

SMART System Training — Floor Management Manual
SMART System Training — Jackpot/Fill Functions Manual

SMART System Training — Marketing Manual
SMART System Training — MIS Manual
SMART System Training — Security Manual

SMART System Training — System Configuration Manual

SMART 2 System Products

Title
SMART 2 Quick Reference Card — Jackpot/Fills
SMART 2 Quick Reference Card — Maintenance
SMART 2.0.5 Club Manager Flow Guide
SMART 2.0.5 Club Operator Flow Guide
SMART 2.0.5 End of Period Flow Guide
SMART 2.0.5 Gateway Manual
SMART 2.0.5 Jackpot/Fill Flow Guide
SMART 2.0.5 SE Guide
SMART 2.0.5 System Configuration Flow Guide
SMART 2.0.5 User's Guide
SMART 2.1.1 Casino Floor Manager User's Guide
SMART 2.1.1 Club Manager Flow Guide
SMART 2.1.1 Club Operator Flow Guide
SMART 2.1.1 End of Period Flow Guide
SMART 2.1.1 Gateway Manual
SMART 2.1.1 Jackpot/Fill Flow Guide
SMART 2.1.1 SE Guide
SMART 2.1.1 System Configuration Flow Guide
SMART 2.1.1 User's Guide
SMART 2.1.3 Update Package, SE Guide
SMART 2.1.3 Update Package, User/Flow Guide
SMART 2.5.2 Update Package on CD-ROM
SMART 2X Club Manager Flow Guide
SMART 2X Club Operator Flow Guide
SMART 2X End of Period Flow Guide
SMART 2X Floor Guide
SMART 2X Jackpot/Fill Flow Guide
SMART 2X System Configuration Flow Guide

SMART 2X System Hardware (replaces 821-513-XX, 821-160-XX, 821-161-XX,

821-170-XX)
SMART 2X User's Guide

SMART 3 System Products

Title

SMART 3 Quick Reference Cards — Jackpot and Fill
SMART 3 Quick Reference Cards — System Maintenance

SMART 3 Stored Value Card (SVC) Reader

SMART 3 System Hardware Guide (replaces 821-553-XX)
SMART 3.3 Cashless Supplement to SMART 3 Documentation
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821-166-XX
821-169-XX
821-168-XX
821-173-XX
821-172-XX
821-165-XX
821-159-XX

Part Number
821-575-XX
821-576-XX
821-515-XX
821-516-XX
821-517-XX
821-520-XX
821-518-XX
821-519-XX
821-514-XX
821-512-XX
821-532-XX
821-526-XX
821-527-XX
821-528-XX
821-531-XX
821-529-XX
821-530-XX
821-525-XX
821-523-XX
821-533-XX
821-534-XX
821-578-XX
821-503-XX
821-504-XX
821-505-XX
821-501-XX
821-506-XX
821-502-XX

821-278-XX
821-500-XX

Part Number
821-542-XX
821-543-XX
821-248-XX
821-574-XX
821-571-XX
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IGS Manuals and Products
Title
* IGS V3.4.X CD-ROM (documentation)
* IGS V3.5.X CD-ROM (documentation)
* IGS 3S Gateway User Guide
* IGS Collection on CD-ROM (documentation)
¢ |GS Demo CD-ROM (system demonstration)
¢ IGS Keyboard Template
* IGS LED Sticker — Bank Controller
* IGS Quick Reference Card — ABS/IGS Bonusing Overview
* IGS Quick Reference Card — GUI Jackpot/Fill by Attendant
* IGS Quick Reference Card — Jackpot/Fill by Attendant
* IGS Quick Reference Card — Jackpot/Fill by Coin Bank
* IGS Quick Reference Card — System Reference Guide
* IGS Quick Reference Card — Wireless Handheld Device
* IGS/Acres System Hardware Manual
* IGS Slot Information Gateway (SIG) User's Guide
* IGS Real-Time Data Interface (RDI) User’s Guide (Preliminary)
* IGS Table Touch User’s Guide Version 1.1
* IGS Table Touch User’s Guide Version 1.2
* IGS Data Management Module (DMM) User’'s Guide Version 1.0
* IGS Data Management Module (DMM) User’'s Guide Version 2.0

Additional Systems Products
Title
e CMS Collection on CD-ROM (Version 3.1-5 documentation)
» System Maintenance 8s Card
* System Maintenance 9s Card

EZ Pay Ticket System Products

Title
* EZ Pay Software Cashier Operations Quick Reference Cards
* EZ Pay Hardware Quick Reference Cards)
* EZ Pay Hardware Quick Reference Cards — Spanish
e EZ Pay Overview CD (system demonstration)
* EZ Pay Floor Operations Quick Reference Cards
* EZ Pay Software Soft Count Quick Reference Cards
* EZ Pay Software Quick Reference Cards — Spanish
* EZ Route CVT Plus Guide
* EZ Route Quick Reference Cards
e EZ Pay Ticket System: User’s Guide Version 1.3
* EZ Pay Ticket System: User's Guide Version 1.4.2
* EZ Pay Ticket System: User’s Guide Version 1.5
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Related IGT Documentation

Part Number
821-661-XX
821-663-XX
821-662-XX
821-660-XX
821-675-XX
821-650-XX
821-314-XX
821-317-XX
821-656-XX
821-655-XX
821-316-XX
821-313-XX
821-665-XX
821-279-XX
821-670-XX
821-671-XX
821-676-00

821-676-01

821-669-01

821-669-02

Part Number
821-690-XX
821-657-XX
821-658-XX

Part Number
821-691-XX
821-745-XX
821-820-XX
821-680-XX
821-692-XX
821-693-XX
821-821-XX
821-348-XX
821-347-XX
821-681-XX
821-683-XX
821-684-XX
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Glossary

ABS Acres Bonusing System ™ This is a complete data
collection and bonusing system using Acres Gaming, Inc.
proprietary technology. It gathers information from a
casino's gaming machines and distributes it to third-
party slot accounting systems, such as IGS.

AC Alternating Current An electric current that reverses its
direction at regularly recurring intervals.

access path The procedure used by a database
management system to access data stored in a database.

access time The time a computer takes to locate and
transfer data to or from storage. Composed of seek time
and transfer rate.

Account Control Executive (ACE) This software consists
of the processes and databases used to define and
maintain configuration details, accounting information
and reporting.

Accounting Analysis System (AAS) The computer
software system used to provide a database of
information. The AAS uses various menu options to
create and print reports.

accounting option The software option that displays
statistics accumulated in game play, such as the number
of coins-in or the number of credits won.

address 1) The unique number assigned to each
component of a larger system. 2) In data transmission, a
code for a specific terminal.

ADSC Accounting Data System Communicator Used with
the IGT Wide Area Progressive Security And Accounting
System to receive and transmit data between the ADS
and CCOM.

agent file A program that performs an information
gathering or processing task in the background. This
type of program is typically given a very small and well-
defined task.

aging period A time period during which information
(usually video lottery ticket information) is held in a
readily accessible database for verification purposes.

algorithm A procedure for solving a particular
mathematical problem in a finite number of steps.

alternating progressive A progressive system in which
there are two meters each associated with the top award
on the gaming machine(s). One meter is set to a higher
base amount than the other. During play on the
machine(s), the meters both progress at the same rate and
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an arrow, or other indicator, flashes back and forth
between the two meters. When the jackpot is ultimately
hit, the player wins whichever amount the arrow is
indicating.

analog Varying smoothly and continuously over a range,
rather than changing in discreet jumps. For example, a
12-hour clock face is an analog device that shows the
time of day by continuously changing the position of the
clock’s hands.

archive 1) To copy programs and data onto an auxiliary
storage medium, such as a disk or a tape, for long-term
retention. 2) To store data for anticipated normal long-
term use. 3) A procedure for transferring image
information from an online optical storage medium to an
offline medium.

asynchronous Not synchronized by a mutual timing
signal or clock.

asynchronous transmission A method of data
transmission in which the receiving and sending devices
don’t share a common timer, and no timing data is
transmitted. Each information character is individually
synchronized, usually by the start and stop of bits. The
time interval between characters isn’t necessarily fixed.

ATA Advance Technology Attachment ATA cards are used
in Vision machines to program the LCD. These programs
are responsible for playing sounds and displaying
information such as tilt messages and Operator and
Attendant Menu options. The Bonus Game Module
(BGM) is an ATA card that programs the LCD to perform
bonus game functions.

attendant The person who has access to accounting,
diagnostics and other attendant functions by turning the
attendant key switch on the machine.

attendant menu The menu entered by turning the
attendant key switch on a machine which allows access
to accounting, diagnostics and other attendant functions.
This menu appears on the screen and shows what
options are available.

attract mode Visual and/or music options intended to
attract players when the machine is in the idle mode.

autobet An option that enables a player to wager the
same number of credits as the previous game simply by
pressing the Deal-Spin-Start switch.

autocycle The machine automatically cycles through each
test without operator or attendant intervention.
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autohold An option that, when selected in the self test
mode, automatically holds suggested winning
combinations of cards and displays a HELD message
above the cards in a game.

award insert A separate piece of glass or film used when
the exterior glass panel has an opening for an award
insert, such as “4000 coins.”

axiohm printer A small, thermal printer utilizing 62 mm
(2.5) paper to print both receipts and reports off of the
CVT, the cashier, and the audit station. It prints at a rate
of 50 mm (2) per second.

background color The screen color surrounding the game
elements and the game-related information.

backup 1) A term pertaining to procedures or standby
equipment available for use in the event of failure or
overloading of the normally used procedures or
equipment. 2) To make a copy of a program or data in
case the original is lost, damaged or otherwise
inaccessible.

bank controller Data condenser; responsible for
communication between DCNs and other system
components.

banner A setup or downloadable message which is
scrolled across the main menu screen to attract or inform

a player.

bar machines A collective term referring to slant-top and
bar top machines, as opposed to upright machines.

bar top A type of machine designed for installation in a
horizontal bar counter-top or contained in a bar cabinet.
The game is viewed from above the machine while the
player is typically seated.

barcode scanner See handheld terminal.

base amount The starting amount for a progressive
jackpot which is also the amount that is displayed after
the progressive is hit.

battery backup Auxiliary power provided to a computer
so that volatile information is not lost during a power
failure.

battery-backed RAM A RAM chip with a built-in battery
for preserving the contents if machine power is turned
off.

baud A unit of data transmission speed.

belly glass The lower glass on the door of some machines
that shows the denomination, paytable or game theme.

Bet Down A screen button that, when touched,
decrements the number of credits wagered toward a
game and returns them to the credit meter. If the button
remains touched, the bet will continue to decrement at a
determined rate until the bet reaches one.
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Bet Max (Bet Five, etc.) A player panel switch or screen
button that wagers either the maximum number of
credits the machine will accept or, if insufficient credits
exist, all remaining credits.

Bet One A player panel switch or screen button that
wagers one credit each time it is pressed.

Bet Up A screen button that, when touched, increments
the number of credits wagered toward a game and
decrements them from the credit meter. If the button
remains touched, the bet will continue to increment at a
determined rate until the bet reaches maximum coins-in
or the credit meter reaches zero.

bill acceptor (same as bill validator) Optional assembly that
accepts valid paper bills and causes the host machine to
either dispense change or issue credits.

bill acceptor pay mode The available options are credit
only (pays only in the form of credits), player initiated
(pays either credits or cash depending on the player
initiated selection) and noncredit.

bill validator (same as bill acceptor) Optional assembly that
accepts valid paper bills and causes the host machine to
either dispense change or issue credits.

bill validator door The door which prevents access to the
bills accumulated by the bill validator.

binary Characterized by having two different
components or by having only two alternatives or values
available.

binary system 1) A number system that uses only 0 and 1
as digits. 2) The representation of numbers in the base-2
system, using only the two digits 0 and 1. A single binary
digit—a 0 or a1 -is called a bit.

bit A contraction of binary digit. The smallest unit of
information that a computer can hold. The value of a bit
is either 1 or 0.

bit rate The speed at which bits are transmitted, usually
expressed as bits per second or bps.

BITBLITZ IGT proprietary designed video controller on
the processor board which provides unmatched speed,
resolution and animation capabilities.

bonus An adjustment built into the paytable of a gaming
machine to pay the player additional coins for a given
win as a reward for playing the maximum coins. For
example, on a three coin multiplier game, a particular
combination might pay 100 coins with one coin played,
200 coins with two coins played, and 500 coins with the
maximum of three coins played. The 500 coin pay in this
case contains a 200 coin bonus for playing with the
maximum coins.

Bonus button Used for interaction with ABS. Allows the
player to confirm receipt of bonus.
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bonus pay Expanded pay for top awards won with
maximum coins bet, greater than a linear multiple of the
wager. If the top award multiplier (number of coins paid
per coin bet) is 300 for one to four coins bet, it might be
900 for five (max) coin bet. See multiplier pay.

bonus server Microcomputer used for bonusing
applications.

boot (same as power up) To start up a computer.

bps (bits per second) (same as bit rate) The speed at which
bits are transmitted, usually expressed as bits per second
or bps.

browse An option in various menus that allows the user
to view data in a file without changing the information.

buffer 1) An area of memory set aside for the specific
purpose of holding data until it is needed. 2) A holding
area of the computer’s memory where information can
be stored by one program or device and then read at a
different rate by another.

bus 1) A path along which information is transmitted
electronically within a computer. 2) An electrical or
electronic connection between devices.

bus specification The specification describing the
physical characteristics of the bus and the protocol that
governs the use of the bus.

buy-a-pay A type of game in which the player buys
various paying combinations by playing more coins.
Usually, buy-a-pay games will pay their top award only
if the maximum coins have been played.

byte A unit of information consisting of eight bits.

cabinet The exterior, laminated wood shell that
surrounds the metal enclosure on some machines.

cage A secure area in a casino used to handle and store
large amounts of money:.

cancel 1) A keyboard operation that deletes the line
currently being typed. 2) To end a task before it is
completed.

candle See Service Light.

CAP Color Attribute PROM Contains color definitions
used to build images on the screen during each phase of
a video game.

card 1) A printed-circuit board that plugs into one of the
computer’s expansion slots, allowing the computer to
use one or more peripheral devices such as disk drives. 2)
A printed-circuit board or card connected to the bus in
parallel with other cards.
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card box (Player Tracking or PT unit) The card box
(PT unit) has a card reader that scans a member’s card
and sends the card ID number to the system so the
records can be accessed. It also has a display unit to greet
the member, show points, etc.

card cage A sealed box in the machine that houses the
programmed information for the game type being
played. It requires a key to access it. This is also called the
lower module.

card reader This is basically a player tracking input
function although LEDs (ERR and OK) are available as
outputs for a reader without a display. There are
currently two different types of cards and card readers:
1) The Hollerith type that uses a card with punched holes
for encoding and a reader utilizing LEDs and
phototransistors to read it. 2) The mag stripe that uses a
card with up to three magnetically encoded tracks and a
reader equipped with a magnetic head to read card data.

carousel A collection of machines with a common jackpot
linked together via fiber-optic cables in one specific area
or location.

cash out A switch that converts machine credits to cash or
payable vouchers. The Cash Out switch on the player
panel activates this machine function.

cash slip A printed ticket from a video lottery terminal
(VLT) that is redeemed for cash in lieu of direct payment
as with a gaming machine.

Cathode Ray Tube (CRT) An electronic tube with a
screen, such as a television picture tube, upon which
information can be displayed.

CC Cluster Controller 1) A down-line processor that
collects data from a number of machines, then transmits
concentrated data over a single communications channel.
2) A communication device that stores, validates and
forwards accounting and security data to the central
system. The most common cluster controllers are CVTs,
LCTs, and LCOMs. 3) An intelligent communications
device at a remote site that is responsible for polling the
machines.

CCITT Consultative Committee on International Telegraphy
and Telephony An international committee that sets
standards and makes recommendations for international
communication.

CCOM Casino Communicator Used with all wide area
progressive systems, such as Megabucks® or
Quartermania® systems.

central computer The central processor located at a
central site.

Central Computer System (CCS) In linked games,
monitors game machine operation and collects
accounting and security information.
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Central Processing Unit (CPU) The brain of the
computer; the microprocessor that performs the actual
computations in machine language.

central site The physical place where the central system is
located.

central system The hardware at the central site, along
with the software used to operate and control the retail
sites.

CFE Communications Front-End 1) A processor on the
network that is between the Real Time System’s
processor and the cluster controllers at the remote site.
The CFE is responsible for communicating with and
polling the cluster controllers. When it is polled by the
real time system it responds with the data gathered from
the CCs. 2) A computer system that controls the transfer
of data from the cluster controller to the central system.

CG Character Generator chip. A character generator chip
located on a processor board that generates images on
video monitors.

character Any symbol that has a widely understood
meaning and thus can convey information. Some
characters include letters, numbers and punctuation.

checksum The result of an arithmetic operation on the
number of bits in a sequence, used to verify the integrity
of game data in the EPROM.

circuit board A board containing embedded circuits and
an attached collection of integrated circuits (chips).

circuitry A network of wires, chips, resistors and other
electronic devices and connections.

CISC Complex Instruction Set Computer A type of central
processing unit found in the majority of personal
computers. It requires several clock pulses to complete
one instruction.

Clerk Validation Terminal (CVT) A cluster controller
that has a keyboard and the ability to print sales reports.
The cluster controller stores the data collected from the
machines located at a particular location. Used by a
cashier to validate printed cash-out tickets (for lottery
games) prior to cash redemption.

Clerk Validation Terminal Plus (CVT-Plus) A cluster
controller having an 80960 processor and a keyboard (as
opposed to the original CVT’s 8032 processor, keyboard,
and built-in printer). The cluster controller stores the
data collected from the machines located at a particular
location. Used by a cashier to validate printed cash-out
tickets (for lottery games) prior to cash redemption.

clock 1) A timing device that generates the basic periodic
signal used to control the timing of all operations in a
computer. 2) A device that records the progress of real
time, or some approximation of it, and whose contents
are available to a computer program.
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clock chip A special chip in which parameter RAM and
the current setting for the date and time are stored. This
chip is powered by a battery when the system is off, thus
preserving the information.

clock speed The rate at which a microprocessor executes
instructions.

Cluster Controller (CC) 1) A down-line processor that
collects data from a number of machines, then transmits
concentrated data over a single communications channel.
2) A communication device that stores, validates and
forwards accounting and security data to the central
system. The most common cluster controllers are CVTs,
LCTs, and LCOMs. 3) An intelligent communications
device at the remote site that is responsible for polling
the machines.

CMOS memory Complementary Metal Oxide Semiconductor
memory RAM chips used to store data for most IGT
games. These can also come in a package with a built-in
battery to preserve the contents if machine power is lost.
See Battery-Backed RAM.

coaxial cable A special type of communications cable that
permits transmission of data at high speed. Usually
employed by local networks.

coin comparitor An electronic coin acceptor mechanism
that receives and validates coins deposited in the
machine. A coin comparitor uses a sample coin against
which incoming coins are compared for validity.

coin drop box The container in the bottom of the cabinet
that catches and holds coins from the coin-in assembly.

coin drop-box sensor switch This switch monitors the
number of times the drop (cash) door is opened.

coin tray Metal tray on a machine where coins are paid
out or returned.

coin-in Coins wagered. The coin-in assembly receives,
verifies, counts and appropriately routes coins deposited
in the machine. The coin-in meters (mechanical and
software) accumulate total coin-in numbers.

coin-out Coins or credits won and paid, or credits won
and wagered. The coin-out meters (mechanical and
software) accumulate total coin-out numbers.

collective remote candle Several machines connected to
one candle.

communication 1) The flow of information from one
point (the source) to another (the receiver). 2) The act of
transmitting or making known. 3) The process by which
information is exchanged between individuals through
the use of a commonly accepted set of symbols.

communication mode An operating state in which a
serial card or port is prepared to exchange data and
signals with a modem or other type of data
communication equipment (DCE).
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communication system Any one of several system
configurations linking machines and a control device
(LCOM, CVT or modem) via fiber-optic cables to a
central computer for the purpose of gathering accounting
data.

communications channel The physical means of
connecting one location or device to another for the
purpose of transmitting and receiving data. Coaxial
cables, fiber optics, microwave signals, telephone lines
and satellite communications all serve as communication
channels.

Communications Front-End (CFE) 1) A processor on the
network that is between the Real Time System’s
processor and the cluster controllers at the remote site.
The CFE is responsible for communicating with and
polling the cluster controllers. When it is polled by the
real time system it responds with the data gathered from
the CCs. 2) A computer system that controls the transfer
of data from the cluster controller to the central system.

communications protocol A set of communication rules
that provides for error checking between devices and
ensures that transmitted data are not lost.

concentrator Data control switch to route data flow to/
from the slot bank(s) and bonus server, and to/from the
slot bank(s) to IGS.

configuration 1) A general-purpose computer term that
can refer to the way a computer is set up. 2) The total
combination of hardware components that make up a
computer system. 3) The software settings that allow
various hardware components of a computer system to
communicate with one another.

configuration workstation Console for ABS and the only
user interface with the system; configures parameters for
ABS.

configure To change software or hardware actions by
changing settings.

contribution The percentage of total play into a machine
that is applied to the progressive jackpots and reserve
funds. The number is divided by all locations on line
based on the amount of play per each game at that
location.

control character A non printing character that controls or
modifies the way information is printed or displayed.

controlling central agency The entity that has full
responsibility for the operation and maintenance of the
gaming system.

coprocessor An auxiliary processor that is designed to
relieve the demand on the main processor by performing
a few specific tasks.
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CPU Central Processing Unit The major component of a
computer system with the circuitry to control the
interpretation and execution of instructions.

CRC Cyclic Redundancy Check Signals, sent between
microprocessor devices, to prevent tampering or
incorrect data being sent.

credit One credit is equal to the denomination of the game
being played. Games are played using credits for ease of
displaying the amount bet and won.

credit limit The maximum number of credits the machine
will accumulate before causing either a hopper-pay;,
handpay or cashout ticket situation.

credit play Allows all awards, except the top award and
handpays, to accumulate on the Credits display rather
than dispensing from the hopper. Some game versions
allow player-selected credit or noncredit play.

credits cancelled Credits handpaid (but not won), that are
cashed out of the credit meter. These credits could come
from either a coin-in or a bill acceptor.

credits collected The sum of credits won and credits
cancelled that are paid out during cashout.

Cross Validation Unit (XVU) A device that allows
several clerk validation terminals (CVTs) to share ticket
data so that patrons can redeem tickets at any other
system-linked CVT or machine.

CRT Cathode-Ray Tube An electronic tube with a screen,
such as a television picture tube, upon which
information can be displayed.

current contribution amount The value of the prize
contribution at the current point of time.

cursor 1) The moving, sliding, or blinking symbol on a
CRT screen that indicates where the next character will
appear. 2) A symbol displayed on the video monitor in
the self test mode indicating where the user’s next action
will take effect.

CVT Clerk Validation Terminal A cluster controller that has
a keyboard and the ability to print sales reports. The
cluster controller stores the data collected from the
machines located at a particular location. Used by a
cashier to validate printed cash-out tickets (for lottery
games) prior to cash redemption.

CVT-Plus Clerk Validation Terminal Plus A cluster
controller having an 80960 processor and a keyboard (as
opposed to the original CVT’s 8032 processor, keyboard,
and built-in printer). The cluster controller stores the
data collected from the machines located at a particular
location. Used by a cashier to validate printed cash-out
tickets (for lottery games) prior to cash redemption.

DACOM Dutch Asynchronous Communication System A
data collection system used only in Holland.
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daisy chain A colloquial term for a group of devices
connected to a host device, where the first device in the
chain is connected to the host, the second device is
connected to the first and the third device is connected to
the second, and so on. To link together sequentially.

data Information.

data bits In the stream of bits being sent from a computer
to a peripheral device or another computer, the bits that
contain meaningful information.

data bus The path along which general information is
transmitted within the computer.

data byte The bytes that contain meaningful information
in the stream of bytes sent from the computer to a
peripheral device or another computer.

data communications 1) The movement of encoded
information by means of electrical transmission systems.
2) The entire process and science of enabling digital
devices, such as computers, to communicate with each
other.

data encryption A coding technique used to secure
sensitive data by mixing or jumbling the data according
to a predetermined format.

database A collection of information organized in a form
that can be readily manipulated and sorted by a
computer user.

database management system A software system for
organizing, storing, retrieving, analyzing and modifying
information in a database.

day meters The data resulting from the last daily poll of
the machines. They provide the data on the number of
games played and won, dollars played and won, and
other critical information.

DC Direct Current An electric current flowing in one
direction.

DCN Data Collection Node An electronic circuit board
connected to each game in the Acres Bonusing System™.
It handles communication between the host and
machine, receives bonus promotions from bonus servers,
and sends bonus-related information to bonus servers,
concentrator and host.

DCS Data Communication System One of several optional
communication systems whereby the machine sends
selected data to an external accounting device.

DCU Data Collection Unit A device capable of collecting
and storing information (real-time data) from up to 32
card boxes. It also receives data and messages from the
FEC for transfer to the card boxes.
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decimal number A numeral, usually of more than one
digit, representing a sum in which the quantity
represented by each digit is based on a radix of 10. The
digits used are 0, 1,2, 3,4,5,6,7,8,9.

decimal system The commonly used form of number
representation, in which numbers are expressed in the
base-10 system, using the ten digits 0 through 9.

default A value, action, or setting that a computer system
assumes, unless the user gives an explicit instruction to
the contrary.

degauss To correct video display discoloration by
neutralizing the magnetic field of a video monitor using
a special degaussing tool.

delete 1) To remove or eliminate, as to erase data from a
field or to eliminate a record from a file. 2) A method of
erasing data.

denomination A factor that determines the monetary
value of one unit of credit.

diagnostics The mode in which the machine can be tested
for module replacement. Tests for I/O (input/output),
peripherals, display devices, and other hardware may be
included.

dialog box A window that appears over the main screen
to provide information to the user or to request
information from the user. The dialog box normally
requires a response or acknowledgment from the user.

digital Represented in a discrete (noncontinuous) form,
such as numerical digits or integers.

Digital-to-Analog Converter (DAC) A device that
converts quantities from digital to analog form.

DIP switch Dual In-line Package switch A small switch that
can be manually set for one of two different values
(usually on or off). DIP switches are used on PC boards
for setting up various machine configurations.

disable When machines are disabled, games cannot be
played, but security event information is still
communicated to the central computer.

disk A flat, circular, magnetic surface, serving as a
medium for storing information.

Disk Operating System (DOS) An operating system
whose principal function is to manage files and
communicate with one or more drives.

display A general term to describe what is seen on the
screen of the display device of a computer.

display board This is the player tracking output accessory
to the SMIB logic board. It contains an encased vacuum
fluorescent display, the driver and negative power
supply for the display, a VIP light, a display control chip
and a connection to the logic board.
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diverter The portion of the coin-in assembly that channels
coins to either the hopper or the drop box.

double up An extended game play available to the player
to double his current winnings.

download To transfer files or information from one
computer to another, or from a computer to a peripheral
device such as a printer.

drop Coins or bills in the drop box.

drop box The container in the bottom of the cabinet that
catches and holds coins when the hopper is full. In bill
acceptors, the lower compartment where bills are
deposited.

drop door The door normally on the bottom of the
machine or in the stand which prevents access to the coin
drop.

drop-door sensor switch Monitors the number of times
the drop (cash) door is opened.

drop hold percentage Also referred to as coin room
percentage. Expression used in some casinos to denote
what percentage of the total drop of a gaming machine is
money actually won. Calculated as follows:

Total Drop - (Fills + Jackpots)
Total Drop

dual-monitor module Optional video monitor assembly
made to attach to and work with a video machine.

DUART/UART Dual Universal Asynchronous Receiver/
Transmitter and Universal Asynchronous Receiver/
Transmitter A communication IC that can interface
between a microprocessor and a serial channel.

E-Squared See EEPROM.

EEPROM Electrical Erasable Programmable Read-Only
Memory Many IGT machines utilize an EEPROM chip
on the motherboard to store backup game data.

EGM Electronic Gaming Machine A gaming machine that
collects and dispenses credits, and houses the games.
This term is also synonymous with VGM, VGD, VLT,
machine and gaming machine.

EISA Extended Industry Standard Architecture A 32-bit
wide bus architecture designed for PCs that supports
multiprocessing and uses either an Intel 80386, 80486, or
Pentium microprocessor.

Electronic Funds Transfer (EFT) A cashless method of
paying for goods or services. Electronic signals between
computers are used to adjust the accounts of the parties
involved in a transaction. Commonly used to make
periodic payments, such as insurance premiums.

enable To activate, usually with a software command.
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enclosure The metal body that houses internal machine
components. The enclosure is often installed in a cabinet.

encryption The password used to encrypt a message in
communications.

End of Day (EOD) See End of Period.

End of Period (EOP) A period of time after which game
play, coin-in, coin-out and other gaming performance
parameters are verified to provide operational control
and management information.

enrollment The process of qualifying a component for
participation in a network.

Enter key A key that confirms an entry or sometimes a
command.

EPROM Erasable Programmable Read-Only Memory A non-
volatile medium for program instructions. Game
programs and video graphics are stored on EPROMs.

error A data processing problem. The machine enters the
tilt mode, an error message displays and game play is
suspended until the problem is corrected.

escalator In slant-top and bar top machines, the part of
the hopper that carries coins up to the coin tray.

ESD Electrostatic Discharge The discharge of electrical
energy that occurs when a charged body comes into close
proximity to an object of lesser or opposite charge.

Ethernet A high-speed local area network that consists of
a cable technology and a series of communication
protocols.

Ethernet cable systems A system of high-performance
coaxial cables widely used in the communications
industry.

Eurocredit A coin-in/credit system used in some gaming
machines that allows the player to insert coins over and
above the maximum number that is playable on a per-
game basis. There is an operator-selectable maximum
credit limit on the Eurocredit machines and players can
insert coins at their discretion until this limit is reached.
Eurocredit machines are most popular in casinos outside
the U.S.

Euro noncredit A credit mode where once the maximum
bet is reached, all inserted coins are accumulated as
credits in the credits meter up to the credit limit. Any
single win greater than the hopper limit is hand paid. All
other wins are paid from the hopper to the coin tray. The
credit limit is set in self test.

event log Allows an operator or attendant to view
metered events recorded by the machine.

exception log A paper record of all reported abnormal
events generated on a wide area progressive system.
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exception message A message that is printed on the
exception printer for any abnormal conditions that cause
status to alter from normal.

expanded paytable glass The lower glass on a machine
that shows an extension of the upper glass paytable.

expanded reel The term used to describe an electronic slot
machine in which the number of reel stops in the
computer program is greater than the number of stops on
the actual reels of the slot machine.

extended industry standard architecture (EISA) A 32-bit
wide bus architecture designed for PCs that supports
multiprocessing and uses either an Intel 80386, 80486, or
Pentium microprocessor.

EZ Pay System which allows ticket validation at the
electronic gaming machine (EGM), clerk validation
terminal (CVT), and cashier’s window.

FAT File Allocation Table The table that the operating
system (OS) uses to locate files on a disk.

FCON Fiber Converter An electronic device that converts
fiber-optic light signals to electrical signals for 4-wire
transmission.

FEC Front-End Controller A dedicated computer that polls
machine data from the DCUs for transfer to the
Transaction Processor (TP). It also sends information
from the TP back through the DCUs to the card boxes.
All messages and data, whether received or sent by the
FEC, must be in RS-232 computer readable code.

fiber optics The transmission of information with light
energy as the transmission carrier and plastic or glass as
the medium.

fiber-optic cable A transmission medium that carries
pulses of light over strands of glass. Fiber optics can
carry hundreds of millions of bits per second over
thousands of miles. Since the glass fibers are carrying
light, they do not receive outside interference and do not
lose appreciable strength. Fiber-optic transmission
reduces errors in transmission. A fiber-optic cable
contains two glass strands. Each strand or fiber is
covered in a sheath made of plastic.

fiber-optic interface board Any one of several optional
PC boards that convert electronic digital data to light for
fiber-optic transmission.

Fiber T A device for branching fiber-optic communication
runs or amplifying a fiber run that exceeds 80 feet.

field A single piece of information, the smallest unit
normally manipulated by a database management
system. A record is made up of one or more fields.

Field Service Manual (FSM) An IGT service publication
covering machine hardware, including: installation,
maintenance, troubleshooting, disassembly and
assembly, parts lists, wiring diagrams and schematics.

January 15, 2004

field service supplement An IGT service publication that
describes hardware and software specific to a certain
machine or jurisdiction.

file Any named ordered collection of information stored
on a disk.

File Allocation Table (FAT) The table that the operating
system (OS) uses to locate files on a disk.

filename The name that identifies a file.

fill Coins that are added to the hopper of a gaming
machine that has become empty as a result of player
wins.

firmware Programs stored permanently in read-only
memory (ROM).

FLASH Also referred to as programmable and erasable
read-only memory which is a device that allows data to
be rewritten.

flash card A credit card-sized memory device used in the
LCD unit for bonus game and attract message storage.

floppy disk A disk made of flexible plastic, as opposed to
a hard disk made of metal.

fluorescent flasher Controls the fluorescent lights on the
machine that indicate the player is in bonus mode.

format 1) The form in which information is organized or
presented. 2) The general shape and appearance of a
printer’s output. 3) To divide a disk into tracks and
sectors where information can be stored.

frequency The number of complete cycles transmitted per
second, usually expressed in hertz.

full-duplex communication A method of data
transmission where two devices transmit data
simultaneously. This method allows the receiving device
to echo back each character of the message as it is
received.

function keys Specially designed keys that, when
pressed, initiate a function on a computer keyboard,
word processor or graphics terminal.

funding entity The entity that accounts for and finances a
prize amount.

game A program designed to offer a player chances to
win prizes by betting some unit of credit of the correct
denomination. There can be several games in one
machine.

game closed mode Inlinked games, describes suspension
of normal game play by the central computer system.

game code The second half of the model code; it refers to
which game type is represented by glass or software (i.e.,
Joker Poker = XX65.)
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Game King® machine IGT Class III video gaming device
powered by the Intel® 80960 processor. Firmware
options include multi-game or single game themes.
Available in bar top, slant top, and upright models.

game play mode The operational mode that exists when
the machine is functioning properly and a customer is
playing a game.

game speed The pace at which a game is played. This
may be set by a player or an operator in the setup mode.

ghost A stop on a slot reel which does not contain a slot
symbol.

gigabyte (GB) A unit of measurement equal to 1024
megabytes.

group A set of progressive prizes with a reserve fund. The
prizes all have the same base denomination and funding
entity.

half-duplex communication A way of communicating
between one computer and another computer, or a
peripheral device in which data can only be sent or
received, not both at one time.

hand In video poker games, one set of five cards. A
standard poker game consists of an original hand, and
after the player keeps or rejects cards, a final hand. Wins
or losses are based on the final hand.

handpay Money award paid by an attendant rather than
being dispensed by the machine.

handheld terminal (same as wand or scanner) A portable
device used to read machine data and then download the
information to a computer.

handle pulls The total number of pulls of the machine
handle. Also known as games played.

hard count The counting of money generated by gaming
operations in the form of coins.

hard drop The controlled process of removing coins from
gaming machines.

hard meters An internal accounting system that is
displayed on mechanical meters on all video and reel
gaming machines. These meters are not resettable, i.e.
they are at zero when the machine is built and they
continue to count the cumulative number of coins in, out,
etc. throughout the life of the machine.

hertz (Hz) An expression used to describe the frequency
of the power line voltage supplied to the gaming
machine, e.g., 50 hertz, 60 hertz.

hexadecimal system The representation of numbers in
the base-16 system using the ten digits, 0 through 9, and
the six letters, A through F.
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hit frequency A term used to describe the average
frequency at which winning game outcomes will occur
on a gaming machine. It is calculated by dividing the
number of individual hits, or winning games, by the
number of possible game outcome combinations.

Hold The physical button on video poker machines that,
when pressed, allows the player to keep cards in a poker
game.

hold percentage The percent of coins played that are
retained or won by the gaming machine. It is calculated
by subtracting the payback percentage from 100 percent.

holeywheel hopper A type of hopper mechanism,
initially developed for large, heavy coins, that uses a
punched rotating wheel to collect coins from the hopper
bowl, and separate them from the other coins for
transport to the eject area.

hopper An assembly inside the machine that receives,
holds and dispenses coins. When the hopper is full, coins
are diverted to the drop box.

hopper probe A simple electromechanical sensing
element located in the coin hopper. When the coin mass
in the hopper bowl reaches and touches the hopper
probe, a signal is sent to the microcomputer indicating
that the hopper is full. See diverter.

host computer 1) A central processing unit that provides
the computing power for the remote terminals and
peripheral devices connected to it. 2) The computer that
is in charge during a telecommunications or local area
network session. 3) The central controlling computer in a
network of computers.

host machine A machine used in conjunction with
another assembly that cannot stand alone, such as a dual-
monitor module or a bill acceptor.

hybrid A term utilized by phone companies to define the
unit in telephone rooms where a phone company circuit
ends and the in-house wiring begins.

IBA Imbedded Bill Acceptor The bill acceptor is considered
imbedded whether it is in a cabinet or top box format. See
bill acceptor.

icon 1) A symbol that graphically represents an object, a
concept, or a message. 2) A pictorial representation of a
software function.

idle mode The condition that exists when a game is not
being played and no credits exist on the credit meter.

IGS IGT Gaming Systems A comprehensive group of
casino management products used by gaming sites for
accounting and player tracking purposes.

IGT Progressive Controller IPC A progressive controller
that has the ability to control up to 32 progressives on a
bank of up to 63 local IGT game machines.
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initialize 1) To set to an initial state or value in
preparation for some computation. 2) To prepare a blank
disk to receive information by organizing its surface into
tracks and sectors (format).

input The introduction of data from an external storage
medium into a computer’s internal storage unit.

input/output (I/0) The inputs and outputs of a machine.
Typically, inputs are from switches, etc., and outputs are
to lamps, etc.

insert A separate piece of glass or film that contains
information not printed on the exterior glass panel. This
can be award amounts, a paytable, or other important
information.

Intel 8032 Microprocessor The microprocessor used in
certain SMART System floor devices, SMIB, DCU, and
SMART card reader, as well as the CVT, S-Plus and PE-
Plus machines.

interface 1) The point at which independent systems or
device groups interact. The devices, rules or conventions
by which one component of a system communicates with
another. 2) The part of a program that defines constants,
variables, and data structures, rather than procedures.
3) The equipment that accepts electrical signals from one
part of a computer system and renders them into a form
that can be used by another part. 4) Hardware or
software that links the computer to a device. 5) To
convert signals from one form to another and pass them
between two pieces of equipment.

interface card A card that handles the interface (or
connection) between the computer and a particular
peripheral device.

IPT Imbedded Player Tracking Enables the owner/operator
to identify and gather information about playing
patterns on individuals through the use of customer
membership cards.

jackpot reset switch (same as reset switch) A key-activated
switch that: (a) enables option selections within some self
test pages; (b) enters and advances through the statistical
data mode; and (c) resets the machine’s internal
progressive parameters (as applicable) after a jackpot.

Java™ A cross-platform, object-oriented programming
language developed by Sun Microsystems.

jurisdiction An authority within which all gaming
regulations are governed.

K (same as kilobyte) A unit of measurement consisting of
1024 bytes. K can also stand for the number 1024 in
which case Kbyte is used for kilobyte.

Kbyte (same as kilobyte) A unit of measurement consisting
of 1024 bytes. K can also stand for the number 1024 in
which case Kbyte is used for kilobyte.
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kilobyte (K) A unit of measurement consisting of 1024
bytes. K can also stand for the number 1024 in which case
Kbyte is used for kilobyte.

kilohertz (kHz) A unit of measurement of frequency,
equal to 1,000 hertz.

LAN Local Area Network A group of computers connected
for the purpose of sharing resources.

LCD Liquid Crystal Display A color active-matrix display
similar to a laptop personal computer. This display is
located in the top box and is used for bonus games,
custom attract messages and a variety of diagnostic and
setup displays.

LCT Local Communication Terminal A cluster controller
that collects data from machines and transmits it to a
central computer.

LED Light Emitting Diode An electronic component that
glows when supplied with a specified voltage,
commonly used in digital displays and as status
indicators.

light box A plastic bracket containing fluorescent lights to
illuminate the display glass.

light pen A device used to make game selections directly
on the screen in some video games, such as keno.

line lights The payline lamps located adjacent to the pay
lines in the reel glass of a multi-line slot machine. As
coins are inserted, the lamps light in sequence, indicating
the paylines that are activated.

line up A type of game that utilizes spinning slot reels or
a video simulation of reels. A win occurs when reel
symbols line up in a specified manner.

link Two or more machines that are connected to a
progressive meter.

link/standalone progressive Link progressive applies
when the machine is connected in series with a group of
machines and also connected to a progressive controller.
When correctly installed and active, the current
progressive top awards are the same for all machines in
that link. Standalone progressive applies when the
machine is not connected in any way to other machines.
Internal progressive amounts must be set for each
machine.

live system A computer that runs the wide area
progressive games and displays the main system
window.

Local Area Network (LAN) A group of computers
connected for the purpose of sharing resources.

Local Area Progressive (LAP) A group of prizes that is
paid by a funding entity other than the controlling
central agency.
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lockout A solenoid device for disallowing coin or token
acceptance.

lockup This situation occurs during some tilt and error
conditions. Game play is suspended but self test and
statistical data modes are operational.

log in (same as log on) To sign-in on a computer.

log off (same as log out) 1) To stop using the computer.
2) The process of signing off the system.

log on (same as log in) To sign-in on a computer.

log out (same as log off) 1) To stop using the computer.
2) The process of signing off the system.

logic door An electronics cage and lock which prevent
access to the main processor board. See card cage.

lottery A jurisdiction in which some form of gambling is
allowed, but typically more restricted than gaming
jurisdictions. A system usually connected to a central
computer via a communication system.

loud bowl A large coin tray designed to resound loudly
as coins are paid out.

lower module A removable assembly within the machine.
The chassis houses the power supply, motherboard,
processor board, connector panels and various optional
assemblies or PC boards.

LSAMS Lottery Security, Accounting, Management System
One of IGT’s lottery systems, including the
communication protocol from the CS (central computer)
to the CC (Cluster Controller) and from the CC to the
machine.

machine A gaming machine. This term is also
synonymous with EGM, gaming machine, VGD, VGM
and VLT. Sometimes a lottery terminal.

machine address (same as polling address) A unique
hexadecimal number resident on a processor board or
communication board, and used by some accounting and
communication systems for machine identification.

machine door On machines, the main access door
typically contains the player switches and/or other input
devices, coin entry, key lock and various other
assemblies.

main door The door on the front of the machine which
prevents access to the printer, hopper, front panel
switches and other operator accessible items.

main menu In a video game or software program, an
initial selection screen where the player or operator
chooses which game to play or portion of the program to
run.
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master file Data stored in a computer system concerning
relatively stable information such as machine serial
numbers and denominations or personal data on club
players for a player tracking system.

max bet (same as max coin) The maximum number of coins
or credits the game will accept for a single play.

max coin (same as max bet) The maximum number of coins
or credits the game will accept for a single play.

max hopper pay The determined amount of coins that the
hopper will pay out before a handpay is needed. Should
correspond with the amount that appears on the glass
insert.

max pay (same as max win) The highest award on the game
paytable.

max win (same as max pay) The highest award on the game
paytable.

megabyte (MB) A unit of measurement equal to 1024
kilobytes, or 1,048,576 bytes.

megahertz (MHz) A measure of transmission frequency
equal to one million hertz.

memory A hardware component of a computer system
that can store information for later retrieval.

memory location A unit of main memory that is
identified by an address and can hold a single item of
information of a fixed size.

menu item A choice in a menu, usually a command to the
current application.

meters Counters. IGT machines utilize both mechanical
and software meters to collect game play data. Hardware
meters collect lifetime totals and cannot be reset.
Software meters are displayed in the statistical data
mode, and can be reset to zero.

microprocessor An integrated circuit on the computer’s
main circuit board. The microprocessor carries out
software instructions by directing the flow of electrical
impulses through the computer.

MIDI Musical Instrument Digital Interface An industry
standard for music being produced digitally.

mix The game types (poker, keno, reel slots, etc.),
configurations (upright, slant-top, or bar top machines),
and denominations on the casino floor. An empirical
ratio adjusted continuously by slot management.

mode An operational state of the machine. IGT machines
typically have five modes: game play, idle, statistical
data, self test and tilt.

modem (acronym for modulator/demodulator) A device that
provides communication capabilities between pieces of
computer equipment over common telephone lines.

75



monitor A display device similar to a television screen
used in video games to receive and display game and
service information.

monitor mask A molded plastic frame that surrounds the
outside edges of the video monitor (or monitors) and
enhances the screen display by reducing glare and light
reflections from inside the machine.

Montana-style credit A credit mode where all inserted
coins are directed to the credits meter up to the credit
limit. In order to place a bet toward the next game, the
player must play a credit. A win that would cause the
credits meter to exceed the credit limit is hopper paid. If
this hopper pay amount is greater than the hopper limit,
the amount is hand paid. All other wins are paid to the
credits meter. The credit limit is set in self test. Anytime
when coins are inserted, the player must play at least one
game before they are allowed to cash out the
accumulated credits.

motherboard A PC board on the lower module that acts
as an interface between the processor board and the
electrical machine assemblies.

MS-DOS Microsoft Disk Operation System An operating
system that governs the IBM PC and compatible
computers.

multi-coin game Allows the player the opportunity to
increase the amount awarded by increasing the amount
wagered.

multi-denomination gaming A type of gaming that
allows players to choose the value of each credit they
wager from a denomination set configured by the
operator.

multi-line game Allows the player the opportunity to
play multiple paylines on reel slots by increasing the
amount wagered.

multiple level progressives Progressive amounts added
to second, third, etc., pay levels and displayed. Limited
only by machine program capability.

multiplier pay Each win amount is a linear multiple of
the number of coins or credits bet. See bonus pay.

multiplexer (MPX or MUX) A device that allows several
communications lines to share one computer data
channel.

NETPLEX An IGT proprietary multidrop serial
communication link between the processor and all
installed peripheral devices used to transfer information
and allow control of peripherals.

network 1) The result of two or more computers being
connected to allow them to share the same software and
information. 2) A system of interconnected computers
and terminals.
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network administration Management of software and
hardware that connects computers in a network.

network administrator The person responsible for setting
up and maintaining a network.

Nevada-style credit A credit mode where coins may only
be inserted up to the maximum bet amount. Any single
win greater than the hopper limit is hand paid. All other
wins are paid to the credits meter up to the maximum
hopper setting.

Nevada-style noncredit A credit mode in an S-Plus
International game where coins may only be inserted up
to the maximum bet amount. Any single win greater
than the hopper limit is hand paid. All other wins are
paid from the hopper to the coin tray.

node 1) Any terminal, computer, or peripheral in a
computer network. 2) The connecting point on a
component, printed circuit board, or logic element where
electrical connections can be made.

noncredit mode The machine will accept no more than
the max bet allowed per game, and all wins are paid out
in coins or by an attendant at the time of the win. If a bill
acceptor is present, it functions as a changer only.

noncredit play The machine will accept no more than the
max bet allowed per game, and all wins are paid out in
coins or by an attendant at the time of the win. If a bill
acceptor is present, it functions as a changer only.

note acceptor (same as note validator) Optional assembly
that accepts valid paper notes and causes the host
machine to either dispense change or issue credits.

note acceptor pay mode The available options are credit
only (pays only in the form of credits), player initiated
(pays either credits or cash depending on the player
initiated selection), and noncredit.

note validator (same as note acceptor) Optional assembly
that accepts valid paper notes and causes the host
machine to either dispense change or issue credits.

note validator door The door which prevents access to the
notes accumulated by the note validator.

NT File System (NTFS) A type of system used by the
Windows NT operating system that organizes and keeps
track of files.

NTEFS NT File System A type of system used by the
Windows NT operating system that organizes and keeps
track of files.

NTSC decoder board An optional PC board that allows
video machines to display an NTSC (National Television
Standards Committee) signal. DIP switches on the board
allow various configurations.

76



nudge The reels in this slot game move up or down one
symbol when a nudge symbol hits. Examples of a nudge
game are Slam Dunk, Balloon Bars and Knock Down.

ODBC Open Database Connectivity A standard database
access method developed by Microsoft that makes it
possible to access any data from application, regardless
of which database management system (DBMS) is
handling the data.

ODBC DSN Open Database Connectivity Data Source Name
See also ODBC or Open Database Connectivity. The
name of the source directory from which data is taken.

offline Not currently communicating with host system.
online Communicating with host system.

Open Database Connectivity (ODBC) A standard
database access method developed by Microsoft that
makes it possible to access any data from any
application, regardless of which database management
system (DBMS) is handling the data.

operator A machine operator, owner, service technician
or any other person with access to the interior of the
machine by opening the front door.

operator menu The menu entered by pressing the test
switch with the main door open that allows access to
accounting, diagnostics, setup and other operator
functions. This menu has an on screen display that shows
what options are available.

operator selectable A value or option that is selectable
only by the operator from the operator menu. The default
value is one selected at machine configuration.

optic sensor An electronic device used to sense
mechanical motion and provide an electrical signal of
this motion to the microcomputer system. In most of the
optic devices used throughout IGT products, there is an
infrared (invisible) light source that emits a beam of light
on a phototransistor. The device is strategically placed in
the machine so that the mechanical motion which is
being sensed will block the light path, thus causing a
signal change in the output of the phototransistor.

optical coin detection The technique of validating coins
being put in or being paid out of a gaming device using
optical detectors.

optimum A calculated payout percentage range for a
poker game assuming an optimum (skilled) play strategy
for each and every hand.

optimum player return The theoretical payback
percentage on a poker machine being played according
to the best case strategy for each and every hand.

ordered royal flush A poker game hand consisting of a
royal flush positioned from left to right on the screen.
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OTP One-Time Programmable A memory device that only
allows information to be loaded once and must be
replaced if a change is needed. See ROM.

out of service mode The machine is rendered inoperable
without turning the power off.

output 1) Data transferred from a computer’s internal
storage unit to some storage or output device. 2) The
final result of data that have been processed by the
computer.

page Invideo games, one full screen display of
information as presented in the self test and statistical
data modes.

parallel interface A personal computer interface that uses
a multiple-path communication line, often used for
printer connection.

partial pay A predetermined number of coins that is paid
to the player from the machine coin hopper upon hitting
a jackpot. The balance of the jackpot is paid by an
attendant. The number of coins paid in the partial pay is
usually operator selectable.

partitioned software A slot machine architecture in
which the machine’s software program is broken down
into two separate sections and stored in two separate
memories. The overall machine operation instructions
are stored separately from the reel strip and paytable
information.

password A special word, code or symbol that must be
presented to the computer system to gain access to its
resources. Used for identification and security purposes.

paytable A chart of pay amounts as a function of each
winning combination and number of coins or credits bet.

paytable glass The top and/or bottom glass that shows
the paytable for that machine.

paytable insert A separate piece of glass or film used
when the exterior glass has a grid printed on it, but needs
an additional paytable insert behind it representing the
paytable.

payback percentage The amount of money the player is
expected to win divided by the amount of money played
over a long period of time, expressed as a percentage. On
games where there is a bonus pay on jackpots won with
maximum coins played, the payback percentage will
vary slightly, depending on how may coins per game are
played.

payout An award from a game.

PCON Plastic Fiber Universal Converter A SMART System
accessory that converts fiber-optic light signals from the
DCUs to RS-232 computer readable code for the FEC. It
also converts signals the other way (RS-232 to light).
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peripheral An intelligent input/output device connected
to the machine such as a touchscreen, a printer, or a bill
validator that communicates to the main processor via
cables and proprietary interface software.

PEROM Programmable and Erasable Read-Only Memory A
device that allows data to be rewritten (same as FLASH).

Personal Computer-Slot Accounting System (PC-SAS) A
data collection package that involves machines linked
together via fiber optics.

physical coins-in The number of actual coins physically
deposited into a game (differentiated from coin-in, which
can be either a coin or a credit that is wagered).

physical stop The actual places where the spinning reel
can stop. There is a stop for each symbol shown on the
reel strip.

pinwheel A rotating steel disc used in coin hoppers to
dispense coins. Small metal pins or raised points located
along the outer circumference of the pinwheel provide
individual pockets where coins can ride along as the
pinwheel rotates. As the coins reach the exit point of the
hopper, they are stripped off the pinwheel by the hopper
knife.

Play Max (same as Play X) A screen button or a physical
button. The Play Max function bets the maximum
number of credits allowed provided there are enough
credits on the credit meter.

Play X (same as Play Max) A screen button or a physical
button. The Play Max function bets the maximum
number of credits allowed provided there are enough
credits on the credit meter.

player digital display In reel slot machines, game
information is presented as an LED digital display
through windows on the slot glass.

player panel switch (same as player switch) An input
switch that communicates player selections to the
processor board. Some player switches also have
functions in self test and statistical data modes.

player selectable credit A gaming machine feature that
allows the player to play the machine in either credit or
noncredit mode.

player server Controls displayed messages that go to the
vacuum fluorescent display.

player switch (same as player panel switch) An input switch
that communicates player selections to the processor
board. Some player switches also have functions in self
test and statistical data modes.

Player Tracking System (PTS) A data collection package
that enables the owner/operator of IGT machines to
identify and gather information about players via ID
cards and readers.
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Player's Edge-Plus® machine IGT Class III video gaming
device powered by the Intel® 8032 processor. This
machine is no longer manufactured by IGT. Parts and
service are available on a limited basis.

poll 1) An electronic request for information, usually
from a central PC or other computer to various
peripheral devices. 2) The process of gathering the meter
information from each game and reporting it to the
central computer.

polling address (same as machine address) The address to
which the machine responds during communication.

pop-up menu A menu that appears on the screen
anywhere other than in the standard menu bar location.

port The connection that allows communication between
a digital system on a PC board and an external device.

power supply A circuit that supplies the DC voltages
required for the operation of an electronic system.
Usually a power supply will convert AC line voltage to
the needed DC voltage for a particular system.

printed-circuit board A hardware component of a
computer or other electronic device, consisting of a flat,
rectangular piece of rigid material, commonly fiber glass,
to which integrated circuits and other electronic
components are connected.

printed ticket Some machines utilize a ticket printer
rather than a coin hopper. When a win occurs and the
player presses the Collect Winnings switch, a printed
ticket dispenses from the machine and can then be
redeemed for cash.

prize amount An amount of money that can be won by
playing a game. This could be a fixed amount or in the
case of a progressive prizes, an amount that increases
based on player activity.

prize base The initial prize amount for a progressive
prize.

prize base reset This value replaces the prize base value
when a progressive prize is won.

prize base revert When a progressive prize is hit this
value is copied to the prize base reset. This allows for a
lower prize base reset when prizes are hit close together.

prize cap The absolute maximum dollar amount that a
prize amount can reach.

prize contribution Each progressive prize has a
contribution percentage associated with it. This factor is
applied to each unit of credit played on the games
associated with the progressive prize. The resulting
contribution amount is used to increment the prize
amount.

prize maximum The highest amount a prize can reach.
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prize maximum boost The maximum dollar amount a
prize amount can grow during a 24-hour period.

probability A number expressing the likelihood of an
occurrence of a specific event.

processor The hardware component of a computer that
performs the actual computation by directly executing
instructions represented in machine language and stored
in main memory.

processor board The printed circuit board assembly in
IGT gaming machines that contains all of the
microcomputer system circuitry, and sometimes the
interface circuitry associated with the game inputs and
outputs.

Programmable Read-Only Memory (PROM) A type of
ROM device that is programmed after fabrication, unlike
ordinary ROM devices, which are programmed during
fabrication.

progressive A system of pooling a fraction of each wager
into a cumulative fund that is available for a top-pay win.
A game that increments the prize amount based on
player participation. The three kinds of progressives are
wide area, local area, and standalone.

progressive controller Controls all progressive functions
in a progressive link system (several machines linked
together to increment progressive totals equally).

progressive meter A display meter, linked to the
progressive machine(s), that shows the potential prize
amounts.

PROM Programmable Read-Only Memory Memory that can
be programmed by electrical pulses. Once programmed,
it is read-only.

protocol Generically the communication standard
between two serial devices. Often used to reference the
type of security, accounting and management systems
that the machine is designed to communicate with.

PRTS Progressive Real Time System This is the live or active
system. It is in constant communication with all the
devices that make up the online progressive system. The
main communications interface of the PRTS is the system
window.

PSR Program Summary Report A three or four page report
that describes the features, capabilities, self test pages
and statistical data information for a game’s program
version.

PTS Player Tracking System A data collection package that
enables the owner/operator to identify and gather
information about players via ID cards and readers.

pull-down menu A menu, usually used as an extension to
the menu bar, that is hidden until you move the pointer
to its title and press the mouse button.
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QUART Quad Universal Asynchronous Receiver Transmitter
A communication device that provides four independent
full-duplex asynchronous receiver/transmitter channels
in one single package.

RAID Redundant Array of Independent (or Inexpensive) Disks
A type of disk drive that uses two or more drives in
tandem for performance and fault tolerance (the system’s
ability to respond to an unexpected hardware/software
failure.) The following RAID levels provide: Level 0: data
striping (spreading out blocks of each file across multiple
disks) but no redundancy. This improves performance
but does not deliver fault tolerance. Level 1: disk
mirroring. Level 3: same as Level 0, but reserves one
dedicated disk to be used for error correction data. This
level provides good performance and some level of fault
tolerance. Level 5: data striping (at the byte level) and
also stripe error correction information. This results in
superior performance and good fault tolerance.

RAM Random Access Memory A memory into which the
user can enter information (write) and extract
information (read). It is the working memory of the
computer as well as the backup memory of game
information that is stored in the CMOS RAM chip on the
processor board.

random A sample drawn from a population so that each
member of the population has an equal chance of being
drawn.

Random Access Memory (RAM) Volatile, digital, read/
write memory that can easily have its bit pattern
changed.

RBP Rapid Bonus Progressive A progressive configuration
that can increment and pay on up to six levels of winning
combinations, rather than just the top and second levels.

Read-Only Memory (ROM) Memory whose contents can
be read but not changed; used for storing firmware.

real time A term describing online computer processing
systems that receive and process data quickly enough to
produce output to control, direct, or affect the outcome of
an ongoing activity or process.

real time clock An optional battery-backed clock on the
processor board used by some games.

Redundant Array of Independent (or Inexpensive) Disks
(RAID) A type of disk drive that uses two or more
drives in tandem for performance and fault tolerance
(the system’s ability to respond to an unexpected
hardware/software failure.) The following RAID levels
provide: Level 0: data striping (spreading out blocks of
each file across multiple disks) but no redundancy. This
improves performance but does not deliver fault
tolerance. Level 1: disk mirroring. Level 3: same as Level
0, but reserves on dedicated disk to be used for error
correction data. This level provides good performance
and some level of fault tolerance. Level 5: data striping
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(at the byte level) and also stripe error correction
information. This results in superior performance and
good fault tolerance.

reel strip A plastic strip with a set of symbols on a slot
reel.

reel strip list Provides exact paytable information and
symbol alignment on each reel, and is shipped with the
machine or with new reel program orders.

Reel Touch Bingo™ Series machine IGT Class II gaming
device powered by the Intel® 80960 processor. May be
configured for either a touchscreen video monitor or
spinning reels. A touchscreen LCD is included in the top
box. Available in upright model only.

Reel Touch™ Series machine IGT Class III spinning reel
gaming device powered by the Intel® 80960 processor.
Includes touchscreen LCD located in the top box.
Available in upright model only.

replicated install During the server configuration
process, SmartStart gives the user the option of creating a
“Replicated Install” diskette which allows the user to
save configuration information into “profiles,” which can
then be used over and over to accelerate the installation
process.

reserve fund This account is used by the funding entity to
accumulate prize contributions to pay for the prize base.
As prize amounts are won, the prize base reset is used to
decrement the amount.

reset amount The starting amount for a progressive
jackpot which is also the amount that is displayed after
the progressive is hit.

reset switch A key-activated switch that: enables option
selections within some self test pages; enters and
advances through the statistical data mode; and resets
the machine’s internal progressive parameters (as
applicable) after a jackpot.

retail site An establishment where gaming machines are
played. This term is also synonymous with location,
venue, and retail location.

RFA Resident Flash Array This is an onboard flash memory
for the Vision LCD operating system that needs periodic
updating to function with new releases of the bonusing
game software.

RISC Reduced Instruction Set Computer A type of central
processing unit that usually has a smaller number of
instructions that can be completed in 1-2 clock pulses.

ROM Read-Only Memory Memory whose contents can be
read but not changed; used for storing firmware.

royal flush A poker game hand consisting of a 10, Jack,
Queen, King, and Ace of the same suit.
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RS-232 A common standard for serial data
communication interfaces.

RS-232 cable Any cable that is wired in accordance with
the RS-232 standard.

RS-422 A standard for serial data communication
interfaces, different from the RS-232 standard in its
electrical characteristics and in its use of differential pairs
for data signals.

RS-485 The electrical interface for a high-speed serial
port.

RTS Real Time System The software which controls the
collection of data from the CVT.

$2000™ machine IGT Class III spinning reel gaming
device powered by the Intel® 80960 processor. This
machine is available in a 3-reel slant top, and 3- or 5-reel
upright models.

$2000™ Barcrest Series machine IGT Class III spinning
reel gaming device featuring a Barcrest top box fitted on
an 5S2000™ base machine. Powered by the Intel® 80960
processor. Available in an upright model only.

S2000™ Bonus Reel Series machine IGT Class III
spinning reel gaming device powered by the Intel®
80960 processor. Includes three conventional spinning
reels and one bonus reel. Available in upright model
only.

S-Plus™ machine IGT Class III spinning reel gaming
device powered by the Intel® 8032 processor. This
machine is no longer manufactured by IGT. Parts and
service are available on a limited basis.

S-Plus™ Limited machine IGT Class III spinning reel
gaming device featuring a Barcrest top box fitted on an S-
Plus™ base machine. Powered by the Intel® 8032
processor. No longer manufactured by IGT. Parts and
service are available on a limited basis.

SAMS Security Accounting Management System A system
that provides a secure environment to operate electronic
gaming devices at a remote location using a cluster
controller for communications with the EGMs.

SAS Slot Accounting System A data collection and
accounting package developed by IGT. Data on machine
activity is transmitted to a controller which, in turn,
transmits the collected data to a computer.

scanner See handheld terminal.

schematic An abstract representation of a complex device
or concept, such as an electrical schematic.

screen button The graphical representation of a button
drawn on the video screen simulating the function of a
physical button when the screen is touched within the
screen button boundary.
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scrolling The vertical or horizontal movement of
information (text or graphics) on a display screen in
order to display additional information.

SDS™ Slot Data System An accounting system product of
Bally Gaming Systems®.

self test mode The software mode that allows processor
board input and output tests and enables option
selections.

self test switch A service control switch that enters and
advances through the self test mode, and enables data
transfer between the CMOS RAM and EEPROM chips.

Semi-Euro credit A credit mode where coins may only be
inserted up to the maximum bet amount. Any single win
greater than the hopper limit is hand paid. A win that
would cause the credits meter to exceed the credit limit is
hopper paid. All other wins are paid to the credit meter.
The credit limit is fixed at 9999.

SENET Synchronous Expansion Network AnIGT
proprietary I/O controller capable of handling 256
inputs and 256 outputs (switches, lamps). An auxiliary
multiplexed channel providing 2,048 additional outputs.

serial communication Data communicated over a single-
path communication line, one bit at a time.

serial interface An interface driver that controls
communication via serial ports, between application and
serial peripheral devices.

serial number The machine serial number which is
stamped into the serial number tag on the outside of the
machine.

server A network computer or device that manages the
network’s resources. Servers are often dedicated (they
perform only their server tasks.) However, on
multiprocessing operating systems, a single computer
can simultaneously execute several programs. In this
case, the server would refer to the program that is
managing the network’s resources rather than the entire
computer.

service light (candle) A light assembly that mounts either
on top of the machine or in a remote location and
indicates various machine modes and game conditions.
Most service lights have two or more stages, or sections,
stacked vertically.

seven-segment display An LED display device that is
composed of seven separate straight bars of light that
displays the digits 0 to 9 when the appropriate bars are
illuminated.

shelf wheel A round metal disc attached to the hopper
pinwheel. The shelf wheel works with the pinwheel to
position coins for ejection.
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side eject hopper The standard type hopper in most
upright gaming machines that ejects coins in a sideward
direction.

Simple Network Management Protocol (SNMP) A set of
protocols used to manage complex networks by sending
messages, protocol data units (PDUs), to different parts
of a network. SNMP-compliant devices, known as
agents, store data about themselves in Management
Information Bases (MIBs). When requested, agents send
their MIBS, which report whether a device is functioning
properly, to the SNMP requesters.

single/double progressive Refers to the progressive
operations of one or two top awards. Single progressive
allows only the top award to be progressive. Double
progressive allows the top two awards to be progressive.

SIS Slot Information System A data collection package that
enables the owner/operator of machines to keep
information on players, as well as accounting
information and statistical information related to
machine events.

site An establishment where gaming machines are
played. This term is also synonymous with location,
venue, retail site, and retail location.

site ID A number used by the system to identify a
location data record based on the ADSC, modem and
CCOM numbers.

slant-top A type of machine with a slanted top from
which the game is viewed while the player is typically
seated.

slave monitor board A processor board that controls the
video functions of the upper monitor in a dual-monitor
machine or module.

slot game A type of machine that utilizes spinning slot
reels or a video simulation of reels. A win occurs when
reel symbols line up in a specified manner.

slot handle An optional handle located on the right side
of a slot machine. Pulling the handle after a wager causes
the reels to spin.

Slot Information System (SIS) A data collection package
that enables the owner/operator of machines to keep
information on players, as well as accounting
information and statistical information related to
machine events.

slot reel The part of a slot machine that holds one reel
strip and spins. Machines generally have three or more
independent slot reels.

SMART card reader A device, connected to a workstation
computer, that reads player or employee cards and
allows access to player or employee records for display
or update.
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SMART System Slot Marketing And Revenue Tracking
System Modular system that is capable of providing
player tracking, automating the accounting of a slot
department, strengthening casino slot security and
defining marketing targets.

SmartStart The XVU server configuration process is
guided by Compaq’s SmartStart®, a graphical interface
program. This program prepares the system for the
loading of Microsoft’s Windows NT Server and its
service pack. Next, SmartStart prompts for the loading of
Microsoft’s SQL Server 7 and its service pack, and finally
the EZ Pay Ticket System is installed.

SMIB Slot Machine Interface Board A device containing
logic and interface boards inside the card box or gaming
machine. These boards store machine data until polled
by the DCU.

SNMP Simple Network Management Protocol A set of
protocols used to manage complex networks by sending
messages, protocol data units (PDUs), to different parts
of a network. SNMP-compliant devices, known as
agents, store data about themselves in Management
Information Bases (MIBs). When requested, agents send
their MIBs, which report whether a device is functioning
properly, to the SNMP requesters.

soft count The counting of paper currency and financial
instruments (e.g., markers) generated by gaming
operations.

soft drop The controlled process of removing bills from
bill acceptors located in gaming machines.

soft meter An internal accounting system that can be
displayed on the screen of a video machine, or in the coin
window on a reel slot machine. The signals that
increment or drive the hard meters are derived from the
soft meter data, and the soft meters can be reset to zero.

solenoid An electromagnetic device used to convert
electrical energy into mechanical energy. The solenoid
consists of a coil which, when energized, becomes a
magnet. The magnet then causes a metal component to
move in order to activate a mechanical device.

spectrum display A dot-matrix, multi-color display
device used to display the amounts in a progressive
system.

split pay An option that makes it possible to divide the
game’s cash-out amount between the hopper and the
printer.

SQL Structured Query Language A standardized query
language that allows a user to request information from a
database.

SSR Solid State Relay A relay built primarily from
integrated circuits and other electronic systems
containing no moving parts as part of their prime
functions.
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stand The wood or metal base, housing the drop box, to
which a standard upright machine is attached.

standalone progressive A progressive game played for a
prize amount that can only be won on one machine.

Standard Euro credit A credit mode where once the
maximum bet is reached, all inserted coins are
accumulated as credits in the credits meter up to the
credit limit. A win that would cause the credits meter to
exceed the credit limit is hopper paid. If this hopper pay
amount is greater than the hopper limit, the amount is
hand paid. All other wins are paid to the credits meter.
The credit limit is set in self test.

statistical data mode The software mode that displays
statistics accumulated in the game play mode, such as
the number of coins in or the number of credits won.

stepper motor A motor used for precision motion control.
Stepper motors rotate by applying a pulsed voltage to
their windings. Each pulse causes the stepper motor
shaft to rotate only a few degrees.

straight flush A poker game hand consisting of five cards
of the same suit with consecutive values.

Structured Query Language (SQL) A standardized query
language that allows a user to request information from a
database.

subdirectory A directory within a directory.

super cap The large capacitors, C14 (.22F) on the SMIB
logic board, and C26 (.47F) on the DCU board, which act
as battery backup to RAM. They can maintain RAM up
to seven days.

synchronous Two or more procedures occurring at the
same time controlled by a mutual timing signal or clock.

synchronous transmission A data transmission in which
the bits are transmitted at a fixed rate. The transmitter
and receiver both use the same clock signals for
synchronization.

tape backup A mechanism that reads and writes
information on magnetic tape to provide a copy of user’s
data in case of an accident.

telecommunication Transmitting information in a
telegraphic or telephonic manner by line or radio
transmission.

Telltale-Plus The circuitry which allows the machine to
determine if any of the high security doors, including the
main door, and processor board on the machine were
opened while the power was turned off.

terminal The main console (keyboard and screen) of a
system.

terminator A component used at the end of a daisy-chain
cable run to complete the circuit.
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theoretical hold The percentage of each credit that the
machine will keep as gross profit.

tilt An error in machine operation that suspends game
play. Tilts can be caused by hardware or software
problems and must be corrected before game play can
continue.

Token credit A credit mode only available when the
appropriate set chip has been used to select the credits
per coin (token) amount. By selecting a nonzero number
for the credit amount, the token credit mode can be
selected in self test, while selecting a zero disables the
credit mode. If the game was in token credit mode before
using the set chip to change the credit amount to zero,
the game defaults to Montana-style credit mode when
powered up. (Refer to Montana-style credit.)

top box An enclosed area at the top of the machine that
typically contains a light box and display glass, a candle
and/or various optional assemblies.

top glass A silkscreened piece of glass that fits into the top
part of a game and usually shows the paytable.

top panel The main machine door on bar top and slant-
top machines. The top panel typically contains the player
switches and/or other player input devices, coin entry,
coin tray, video or slot glass and other components.

touch panel A player input device on some video games,
such as touch-panel keno. When the player touches a
designated area on the panel, a corresponding area on
the video screen is activated.

touchscreen A video monitor that also acts as an input
device by the action of touching specific locations of the
screen to perform some activity or action.

touchscreen button The graphical representation of a
button drawn on the screen simulating the function of a
physical button when the screen is touched within the
screen button boundary.

Transaction Processor Engine (TPE) A set of programs
that monitor and control the machines and are
responsible for coordinating prize amounts,
accumulating group meters, gathering game meters data
and ensuring the integrity of the system.

translator Compatibility buffer between ABS and IGS.

Transistor-Transistor Logic (TTL) 1) A family of
integrated circuits having bipolar circuit logic. 2) A
standard for interconnecting such circuits, which defines
the voltages used to represent logical Os and 1s.

twisted-pair wire A type of wire that is made up of a pair
of insulated copper wires twisted around each other to
equalize, and therefore negate, outside electromagnetic
interference. There are two varieties shielded twisted
pair and unshielded twisted pair.
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UART/DUART Universal Asynchronous Receiver/
Transmitter and Dual Universal Asynchronous Receiver/
Transmitter These are integrated circuits that are used to
communicate data from gaming machines to various
accounting and security systems. The UART is a single
device, i.e., one per package. The DUART is a dual
device, i.e., two per package.

unit of credit One unit of credit is equivalent to one unit
of the base denomination associated with the game.

upright machine A type of machine that stands erect,
usually attached to a stand. The machine door is hinged
on the side and the game is viewed from the front.

Vacuum Fluorescent Display (VFD) A small graphic
display used to convey game play, diagnostic, status and
other messages to the player, attendant or operator.

VBatt Battery voltage.

Version 1 CVT The term used to refer to CVTs that are
connected to video/reel machines with hoppers.

Version 2 CVT The term used to refer to CVTs that are
connected to video/reel machines with ticket printers.

VGD Video Gaming Device A gaming machine. This term
is also synonymous with EGM, machine, gaming
machine, VGM and VLT.

VGM Video Gaming Machine A gaming machine. This
term is also synonymous with EGM, machine, gaming
machine, VGD and VLT.

video monitor A display device similar to a television
screen used in video games to receive and display game
and service information.

Vin Voltage in.

virtual reel The term used for electronic slot machines in
which the number of reel stops in the computer program
is greater than the number of stops on the actual reels of
the machine.

Vision Series® machine IGT Class III spinning reel
machine powered by the Intel® 80960 processor.
Includes LCD located in the top box. Available in slant
top and upright models.

VLT Video Lottery Terminal A type of game that is
connected to a central computer system via a
communications system. Video lottery customers often
receive payment in the form of printed tickets that can be
redeemed for cash.

voucher A printed ticket from a video lottery terminal
(VLT) which is redeemed for cash in lieu of direct
payment as with a gaming machine.

Vout Voltage out.

WAN Wide Area Network A network of geographically
distant computers and terminals.
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wand See handheld terminal.

WAP System Wide Area Progressive System A group of
progressive games that are played for a prize amount
funded by the controlling agency. Refers to games such
as Megabucks® and Quartermania®.

Wide Area Network (WAN) A network of geographically
distant computers and terminals.

win Usually refers to the dollar value of a gaming
machine’s hold percentage. It is calculated by
multiplying the coin-in value in dollars times the hold
percentage.

window A portion of the video display area dedicated to
some specified purpose. Special software allows the
screen to be divided into multiple windows that can be
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moved around and made bigger or smaller. Windows
allow the user to treat the computer display screen like a
desktop where various files can remain open
simultaneously.

workstation 1) Anindividual work area that includes one
or more devices on a network 2) A node through which a
user can access a server or other nodes.

XVU Cross Validation Unit A device that allows several
clerk validation terminals (CVTs) to share ticket data so
that patrons can redeem tickets at any other system-
linked CVT or machine.
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